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1.2

Introduction

Welcome

Natara Bonsai outliner is an organizational tool with many uses. Use Bonsai as a
task manager, organize your thoughts for a presentation, or keep important
information handy.

Bonsai is available as both a Windows and a Palm OS application. Use it to outline
ideas, create checklists, or perform simple project management tasks. Bonsai
provides true one step outline synchronization between a Windows desktop and a
Palm OS handheld.

Key features.
e True one-step synchronization using HotSync technology

o Create simple outlines, to do lists or projects

e Multi-line in place editing of text

« Wide range of display options

« Drag to move or change indentation

e Sort on any attribute

o Filter based on multiple criteria

e Supports both a local and the Palm OS find command

e Color and high resolution support

e Support for icons with categories and keywords.

« Attach notes to items

e Link items to the built-in To Do, and date book databases and other outlines

e Assign contacts and keywords to items.

« Beam outlines to other Palm OS devices

e TealPrint™ and PalmPrint™ Palm OS print driver support
What's New

Changesin version 4.0.4
¢ Thiswas amaintenance release. No new features were added.

Changesin version 4.0.3

New on Desktop
e Added menuitem for toggle filter state Alt+T.
e Added shortcut for Outline Sort dialog (F8).
e Recognize additional Thought Manager PDB export format type for import.

Changesin version 4.0.1

© 1999-2006 Natara Software, Inc.
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New on Desktop and Handheld
e Theresultsof aflat filter can be sorted.
e The sort column of aflat filter can be changed by clicking on the column header.
e A Next Action filter type has been added.
e The scope of afilter can be set so that al children of items that match afilter are
included.
e A custom numeric field has been added.
e Ability to filter for items that do not have keywords.
e Added option for completed item text color.

New on Handheld
e Option to retain current graffiti state when launching Bonsai.

New on Desktop
e Spell check (with check while you type in notes pane).
e Expand incomplete items by holding control key while clicking on expand to level
toolbar buttons.
e Click and drag to select multiple items using both index column and selection gutter.
e Rename outline command added to the Outline Manager.
e Save All command
e A plug-in for Google Desktop to index outline files.
e Context menu for outline tabs
e More flexible CSV import.
¢ Better keyboard navigation between columns.
e Import backup PDB's from ThoughtManager and BrainForest.
e Desktop can beinstalled and used without Palm Desktop / HotSync Manager.

Changesin version 3.3.5

New on Handheld
e Added ability to selected from multiple storage card dlots.

Changesin version 3.3.4

New on Desktop
e Added configuration for first day of the week.
e Ctrl+Del to delete the current word.
e Added option to include XSLT in XML export.

New on Handheld
e Added expand-collapse to 5-way up-down configuration.
e Filein DayNotez options are now persisted.
e Option for confirmation prompt when deleting items with notes.

© 1999-2006 Natara Software, Inc.
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Changesin version 3.3.3

New on Desktop
e Added support to drag and drop text from other Windows applications.

Changesin version 3.3.2

New on Desktop
e New replacement options for priority text in export templates.
e Example MPX export template is included.
e Command added to insert afilelink.

Changesin version 3.3.1

New on Desktop
e URL'sare now color highlighted and can be clicked.
¢ Replace command.

New on Handheld
e Option added to disable the shading of the toolbar.

Changesin version 3.2.1

New on Desktop
e Icon support for categories and keywords (uses same icons as handheld).
e Select Keywords from the Iltem menu.
e Link to other outlines from the Item menu.
e Submenu added to select current color scheme.
e Drop arrow for Undo toolbar button to display what actions will be undone.

New on Handheld
e Shading of toolbar added.

Changesin version 3.1.1

New on Desktop
e XML Export (Bonsai) & Import (Bonsai, OPML, Mind Map, Shadow)..
e Link with To Do keyboard shortcut.
e Added amenu item and keyboard shortcut to select al siblings. When on root, selects
al itemsin the outline.
e Added a menu item and shortcuts to edit the active filter.

© 1999-2006 Natara Software, Inc.
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e Control-drag to duplicate a branch.

e Color for parent items that do not match active filter is configurable.

e Keyboard shortcuts added to set item type.

e The position of the notes splitter is saved with the outline. When the outline is again
opened, the splitter position is restored.

e Outlinesimported from aCSV are assigned the default colors and other attributes

e Keyword defaultsfor new items.

e Sort on keywords and contacts.

e A keyboard shortcut, dialog, and command line option to jump to alinked item using its
link tag number.

e Integration with Outlook and the Palm Desktop to jump to linked itemsin Bonsai
outlines.

New on Handheld
e |con support for categories and keywords.
e Configurable named views with collapsible header.
e Jump back to Bonsai from link (both hack and OS 5 application).
e Icon column for Contact.
e Added the private outline attribute to list of columns that can be displayed.
e An alarm can be configured when adding a new event when linking to the calendar.
e Keyword defaults for new items.
e Sort on keywords and contacts.

Changesin version 3.0.3

New on Desktop
e Command line CSV import accepts a category parameter.
e Drag and drop within the Outline Manager.

New on Handheld
e The number of times an outlineis used is counted. This usage counter can be displayed
on the view that lists outline names, and is available in the outline details dialog.
e The category of an outline received by beaming or manual installation is added to the
list of outline categories.

Changesin version 3.0.2

New on Desktop
e Added anew view to the Outline Manager. Outlines can now be organized by folder.
e The Outline Manager now remembers the expand-collapse state.
e Multiple keywords can be selected from the keyword list at one time.
e Keywords can be assigned across multiple selected items.
e Added shortcut key to assign keywordsto items

© 1999-2006 Natara Software, Inc.
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e Added shortcut key ctrl+1 .. ctrl+5 sets priority.
e Added shortcut key alt+1 .. alt+4 expands outline to level.

Changesin version 3.0.1

New on Desktop and Handheld

e A contact name can be associated with items in the outline.

e Keywords can be added to itemsin the outline.

e New iconsfor toolbars.

e Alternating background colors can be configured.

e Itemsin the outline can now be linked to an event in the date book. The links can be
created on the handheld (and show on the desktop).

e Separate color set for each style of coloring is maintained.

e Improvementsto filtering; filter by text, multiple categories, and additional date
options.

e Auto to do link option for new items was added.

e More flexibility in numbering.

New on Desktop

e The Ul can now be configured for either Windows XP or Office 2003 look and fedl.

e Tabbed interface.

e An Outline Manager windows was added. This dockable window shows the names of
outlines organized in a hierarchy. Outline categories can be managed within this
window.

e Bonsai remembers what outlines were open and restores them when it is started again.

e Added Zoom support.

e Dates can be for multi-selected items.

e Context menu improvements.

e Undo support was added for sorting.

e The number of items (and selection count) is shown in the status bar.

e Undo support added for changes to an outline's categories. Itemsthat used a deleted
category are now moved to unfiled.

e Column headers are now printed.

e A command line export can now run even if Bonsai is aready running.

e Theicon used for outline filesis now unique from the Bonsai application outline for
easy recognition. You may not see this change until Windows updates itsicon cache.

o Added #FILTER_NAME#, #CONTACT#, #KEY WORDS# to the list of export
replacements.

e Command line import of aCSV file.

New on Handheld
e The name of the outline is shown asthetitle of the outline details dialog.
e Theitem text isused asthettitle for the details dialog.

© 1999-2006 Natara Software, Inc.
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e For the Treo 600, Option-select does performs command configured for Select.
e New menu item and shortcut to return to the view of outline names.

New in the conduit
e Filtersare synchronized.
e Improved outline synchronization algorithm.

Changesin version 2.8.1

e Added support for the PalmOne Tungsten T3 portrait and landscape 320x480 screen
size.

e Added support for the Handspring Treo 600 5-way navigation buttons.

e Added additional option settings for 5-way navigation buttons.

Changesin version 2.7.1

e Added support for the Sony Clie UX50.
e Added apriority filter of 'has priority'.

Changesin version 2.6.1

Support added for the AlphaSmart Dana wide screen.

Added option to hide the entire branch if an item isfiltered.
Added option to show Simple items when filtering on status.
Sort by Completion date.

Theinstall script has been rewritten to improve compatibility.

1.2.1 Checking for Updated Version

Use the "Check for Update" command on the Help menu of the Bonsai Windows
application to see if a new version of Bonsai is available.

1.3 Installation

How to install Natara Bonsai.

Palm OS Application Only

Download and extract the distribution files for the Bonsai Palm OS application to a
temporary directory. Double-click on the file Bonsai.PRC to run the Palm Install Tool

or the Palm Quick Install to queue the application for installation to your handheld.
The Bonsai application will be installed during the next synchronization.

Windows Desktop Application Only

© 1999-2006 Natara Software, Inc.
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1.4
141

Download and extract the distribution files to a temporary directory. Run the

setup.exe (or run the self-extracting download) and an InstallShield™ application will
guide you through the installation process. When the setup completes, double-click
on the Bonsai icon on the Windows desktop to launch Bonsai.

Windows Desktop with Palm OS Applications

Follow the instructions for installing the Bonsai Windows applications. During the
setup you will be asked to identify the handhelds to install Bonsai on. Perform these
steps after installing to create and synchronize your first outline.

e Start Bonsai by double-clicking the Bonsai icon on your Windows desktop.
Bonsai opens a blank outline.

e Type in an outline.

e Save your outline using the Save command on the File Menu. The name you
give the file will be used as the name of the outline on your Palm device.

e Respond 'Yes' when prompted if you want to synchronize this outline.

e Perform a synchronization to install the Bonsai application on your Palm OS
device.

e Perform a second synchronization. The Bonsai conduit will be run since the
Bonsai application was found on your Palm device.

e Tap on the Bonsai icon on the applications screen.

e Tap on the outline name, and tap open to view your outline.

The license agreement allows you to evaluate Bonsai for 30 days before purchase.
A registration code is required to continue using Bonsai after 30 days of use.

Requirements and Limitations

Requirements

Bonsai has the following requirements.

Windows Desktop Requirements
e Windows 98SE, Windows NT 4.0, Windows 2000 or XP.
e Approximately 15 MB of disk space.

Requirements for Synchronization
e HotSync Manager version 3.0 or greater

e The Back-2-Bonsai Palm Desktop add-in requires Palm Desktop version 4.1
or later.

Palm OS Device System Requirements
e Palm OS 4.0 or greater (Palm OS 5 recommended).

© 1999-2006 Natara Software, Inc.
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e Approximately 540 KB for the application.

1.4.2 Limitations

Bonsai has the following limitations.

Limitations

Each item in the outline is limited to 1000 characters.
The outline depth is limited to 30 levels.

Notes attached to items are limited to 32 KB.

Limit of 15 user defined category names for each outline.

Limitations for Palm OS handhelds

e Total number of outlines and each outline size is limited to available Palm
memory.

e File names used for outlines that are synchronized must be unique within the
first 28 characters.

e The global find command does not search outlines stored on a storage card.

e The Undo command on the handheld only acts on simple editing of text.

1.5 Purchase a License

You can purchase a license for Bonsai from the Natara website at
http://www.natara.com/bonsai/purchase.cfm.

After purchasing a Bonsai license, you will receive a registration number by email
(usually within the hour, but please allow up to 24 hours). Follow the instructions in
the email to enter your registration number in the desktop application's registration
number dialog. The registration number will then be copied to your Palm device
during the next synchronization.

Bonsai Registration

Stl:".'p 1: [ Purchase a Bonzai heenss ]
STF‘F'J 2- Sealeci the user o negister.

m Jirm Tutte b
STeP 31 Puste the iegistation ramber in the fiekd below

‘_.‘.'\\. | |
ST.L'[J 4 Click O 1o vesify and save the regestration .

[ox ] [ coxa |
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1.6

License Agreement
License Agreement

1. GRANT OF LICENSE. Natara Software, Inc. ("Natara"), grants to you, the end user, a personal, nonexclusive license to use
single copy of this software program, including any updates, additional modules, or additional software provided by Natara in
connection therewith (the "Software"), solely for your own use, and solely in accordance with the terms and conditions of this lice
agreement. You may copy the Software into the memory of any computer, solely as necessary to use the Software in accordan
with this license agreement.

2. INSTALLATIONS AND USE. Natara Bonsai is licensed to you in one of two potential configurations: (1) Single User License
(2) Evaluation License. You may install and use (in he manner provided) only those configuration(s) for which you have obtained
license. Licenses for Natara Bonsai are individual named user licenses. No license may be shared, in any capacity, by more tha
one individual end user.

(1) Single User License. You may install and use a single copy of the Software on a single handheld device. You may install th
software on up to two (2) computers that the handheld device synchronizes with. You may access the Software from a hard disk
over a network, or by any other method; strictly in accordance with the terms hereof. You may use each licensed copy of the
Software on up to two (2) computers and a single handheld device.

(2) Evaluation License. You may use one copy of the Software on a single computer and handheld device, for a period not to
exceed thirty (30) days. You are acquiring only the limited right to use a single copy of the Software for evaluation purposes. Yo
are not acquiring any rights to the Software itself.

3. COPYRIGHT AND COPIES. The Software (including any copy thereof), is owned by Natara or its suppliers and is protected b
United States copyright and patent laws and international treaty provisions. The Software copy is licensed, not sold to you, and
are not an owner of any copy thereof. You may either (a) make one copy of the Software solely for backup or archival purposes
(b) transfer the Software to a single hard disk provided you keep the original solely or backup or archival purposes. You may no
otherwise copy the Software except as expressly authorized by applicable law, and you may not copy the written materials
accompanying the Software. Natara hereby reserves all rights not explicitly granted in this software license agreement.

4. OTHER RESTRICTIONS. You may not rent, lease or transfer the Software. You may not reverse engineer, decompile or
disassemble the Software, except to the extent expressly authorized by applicable law.

5. LIMITED WARRANTY AND REMEDY. Natara warrants the physical media (e.g. diskette(s) or CD-ROM), and the physical
documentation, to be free of defects in materials and workmanship for a period of 90 days from the original purchase date. If Na
receives notification within this warranty period of any such defects and such notification is determined to be correct, Natara will,
its sole option and discretion, repair or replace the media or documentation, or provide you a full refund. The foregoing is your s
and exclusive remedy and states Natara's and its suppliers' entire liability arising out of this warranty. This limited warranty is vo
the damage or defect has resulted from accident, abuse or misapplication.

6. NO OTHER WARRANTIES. THE LIMITED WARRANTY ABOVE IS EXCLUSIVE AND IN LIEU OF ALL OTHER CONDITION
AND WARRANTIES FOR THE SOFTWARE AND DOCUMENTATION. NATARA AND ITS SUPPLIERS MAKE NO OTHER
CONDITIONS OR WARRANTIES, EXPRESS, IMPLIED, STATUTORY OR OTHERWISE, AND EXPRESSLY DISCLAIM ALL
OTHER CONDITIONS AND WARRANTIES, INCLUDING BUT NOT LIMITED TO IMPLIED CONDITIONS OR WARRANTIES O
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND NONINFRINGEMENT FOR THE SOFTWARE AND
DOCUMENTATION, TO THE FULLEST EXTENT PERMITTED BY APPLCABLE LAW.

7. LIMITED LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT AND UNDER NO
LEGAL THEORY SHALL NATARA OR ITS SUPPLIERS BE LIABLE TO YOU FOR ANY COSTS OF SUBSTITUTE PRODUCTS
OR FOR ANY CONSEQUENTIAL, SPECIAL, INCIDENTAL, PUNITIVE OR INDIRECT DAMAGES OF ANY KIND ARISING OU
OF THE LICENSE OF, USE OF, OR INABILITY TO USE ANY NATARA SOFTWARE OR DOCUMENTATION, EVEN IF NATAR
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL NATARA'S OR ITS SUPPLIERS'
LIABILITY EXCEED THE LICENSE FEE PAID BY YOU. THIS LIMITATION OF LIABILITY AND RISKS IS REFLECTED IN THE
PRICE OF THE SOFTWARE LICENSE.

8. TERM. This license is effective until terminated. You may terminate it at any time by destroying the Software together with
copies, modifications and merged portions in any form. It will also terminate automatically upon your failure o comply with any te
or condition of this Agreement. In the event of such termination, you agree to promptly destroy the Software together with all co
modifications and merged portions in any form.

9. MISCELLANEOUS. This is the entire Agreement between you and Natara, and supersedes any prior agreement, whether writ
or oral, relating to the subject matter of this Agreement. This Agreement is governed by the laws of the State of lllinois, U.S.A.,

without reference to conflict of laws principles. All disputes arising out of this Agreement shall be litigated or otherwise resolved

exclusively in the state of Illinois. If any provision of this Agreement is ruled invalid, such invalidity shall not affect the validity of

remaining portions of this Agreement.
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1.7  Other Copyrights

This product contains Polar SpellChecker from Polar. Copyright © 1998-2001. All rights
reserved.

2 Outline Fundamentals

Items in the outline are arranged in a hierarchy. Diamond symbols are used for
items that do not have child items. Triangle symbols are used to indicate items that
have children items. The triangles point to the right when the branch is collapsed.

‘Outline Hierarchy IS

¢ 1. This item has no children
W 2. This is a parent
w 2.AThis is a child and parent item.
¢ a. This is a child
¢ b. Asecond child item
D 2.B This parent is collapsed and
hides the children items.

a2 R ERA

Bonsai on a handheld using the Palm OS.

Many of the commands operate on the current item. The current item is the item that
contains the blinking insertion caret.

2.1 ltem Attributes

Each item in the outline has a set of attributes.

Title
This is the text that is displayed as the outline content.

Notes
Additional text associated with the item. Displayed in a separate pane or dialog.

© 1999-2006 Natara Software, Inc.
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Type
Each item in the outline can be one of 3 types; Simple, To Do and Task.

Create Date
The time the item was first added to the outline. This attribute cannot be modified.

Start Date
The date when a To Do or Task should start

Due Date
The date when a To Do or Task should be done.

Completed Date
The date a To Do or Task was completed.

Last Modified Date
Bonsai records the last time any of the item's attributes were modified.

Percent Complete
An indication of the progress of a To Do or Task. The value for a To Do can only
be either 0% or 100%. The percent complete of a Task can be anywhere from 0%
to 100%.

Priority
The importance of the item. The priority is in a range of 1 to 5, with 1 being the
most important. The priority can also be set to a value of None.

Category
This attribute can be used to group like items. Only a single category can be
assigned to each item.

Keywords
Also used to group like items. Multiple keywords can be assigned to each item. In
contrast to categories a much larger number of keywords can be defined.

Contact
This attribute can be used to associate a person with an item. However it can be
used for other purposes since the value is not restricted to an external source.

Link
The item can be linked to other Bonsai outlines, or when used on a handheld
computer it can be linked with a To Do or Calendar entry.

Custom
A general purpose numeric value. This is a signed value with 2 decimal places.
The label assigned to this attribute can be set in the outline preferences. One
possible use of this value is to calculate project cost.

© 1999-2006 Natara Software, Inc.
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Parent of Next Action Items
This yes/no attribute is used in conjunction with a filter option to display the single

child item that should be accomplished next.

Unique Identifier
Bonsai assigns a unique number to each item in the outline. This value is used for
synchronization with handheld computers and is not normally visible.

2.1.1 Item Types
Each item in the outline has a type. Bonsai supports 3 types: Simple, To Do, and

Task.
e Simple items do not have dates or completion status information.
To Do's have dates (start, due, and completed), and a done/not done status.

[ J
Tasks have dates and a percent complete status.

An outline can have items of mixed types. When the preference to show completion
status is enabled, a different symbol is shown for each item type.

i Matara Bonsai - [Iltermn Types] F;IE|E|

{8 Bl Edt Wew Item Quime Window Help . 8 X

L HO B LD

I_*-} 1 2 34“",/ ,-'E::I'F.'l ._.I.
Qutline

This Is a simple item and does not have

a completion status

# [ This To Do is not done.

# & This To Do is completed,

—/This task Is not started.

=0 This task is 50% done.
== T his task is completed.

LN

I Item T*,-pe5|

? ? Mot Filiered - -
[F.:2

|Reach
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r|'|:E.“-'| T‘ypes w Filter Off

¢ - 1.Thisis asimple item and does
not have a completion status.

¢ [ 2.This ToDois not done.

¢ [ 3.This To Do is completed.

¢ 34, This task is not started.

¢ mE35. This task is 50% done.

¢ mm6. This task is completed|

LN B ERd

2.2 Outline Attributes
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2.2.1 Filters

Filters are used to restrict what items in the outline are displayed to highlight some
attribute. For example, completed tasks can be hidden so that the tasks that remain
to be done are seen.

Each filter is given a name so that it can be selected from a list.

Filter Options

e Flat display - When this option is checked the items that match the filter are
displayed as a flat list. When the option is unchecked the outline hierarchy is
maintained.

e Scope - This option can be used to restrict what items are examined. The default
is to apply the filter to all items in the outline.

e Next Action - This option works in conjunction with the
"Parent of Next Action Items" attribute that is applied to parent items in the
outline. When this option is checked Bonsai will examine all the child items of
such a parent and select the first incomplete item (also know as the Next Action).
If that item does not match the other attributes of the filter then none of the
children are displayed.

e Reverse - When this option is checked Bonsai will reverse the result of checking
the filter attributes against an item

Select one or more of the following criteria. When an item in the outline is compared
against the criteria it must match ALL the criteria to be shown.

Filter Criteria

e Status - Select the status of a To Do or Task. For example is the To Do
completed or incomplete.

e Type - Select what type of items should be included. For example only show To
Do's.

¢ Priority - Select what priorities to display. For example only display the highest
priority tasks (priority is 1).

e Link - Display items that are linked to the calendar or To Do's.

e Text - Does the outline item contain the text string.

e Dates - Display items that have certain dates.

e Contact - Display items that have a certain contact name.

e Categories - Display items with given categories. One or more categories can be
included.

e Keywords - Display items with given keywords. There are options for matching
all, any, or none of the keywords.

2.2.2 Colors

The default color for outline text is black. There are also several color schemes that
can be used to color the outline text. Switching between the color schemes can be
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2.2.3

224

performed as needed.

Category
Assign a color to each category

Priority
Assign colors to priorities to highlight important tasks

Outline Level
Assigns color for each level in the outline

Due Date
Highlight tasks that are coming due with color.

A color can also be configured for completed items.

Categories

Each outline has its own set of categories that can be applied to the outline items.
Categories are useful for grouping like items. A filter can then be used to show only
the items within a given category.

To retain compatibility with the Palm OS up to 15 user defined Categories can be
created.

Icons for Category and Keywords

Bonsai has support for displaying icons for categories and keywords. The category
and keyword icons can be shown in outline view columns. Category icons are
configured on the Category tab of the Preferences dialog on the desktop and the
Icon tab of the Preferences dialog of the handheld. Keyword icons are configured
from the keywords dialog.

Bonsai supports the defacto icon standard established by Agendus (formerly Action
Names) and now supported by several other Palm OS applications, such as DateBk
5. Free and commercial icon sets are available online from many download sites.
Here is an example of the Bonsai dialog used to select an icon from the icon set.
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The Palm OS application Icon Manager (authored by Christopher Antos) can be
used to create a private set of icons. At the time of this Bonsai release, Icon
Manager version 1.6 is a free application available from most download sites. Bonsai
can either share the icon set used by other applications or use a private set of icons.
Create an icon database named "Bonsailcons" if you want a private set of icons. If
this private icon database does not exist, Bonsai will use the default set of icons.
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lcon Manager

o Bonsailcons b1 w
27 Fv HiRes Icons 1.6 b1 w

| Tap here for important Sony info. |
™ Cards O Sizes @

During synchronization the Bonsai conduit determines what icon set is being used by
Bonsai on the handheld. The name of the icon set is saved by the conduit for use by
the Bonsai desktop application. When the Bonsai desktop application is run, it will
load the icon set from the HotSync Manager backup directory. Your icons must be
backed up to the desktop in order to be used by the Bonsai desktop application.

j Note:

Bonsai references icons by their resource id. This allows icons to be
moved within icon sets without affecting existing outlines.

j Note:

By convention, icons should be given resource id's in the range from 0 to
8999.

2.3 Actions
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2.3.1 Add Iltems to the Outline

Bonsai is designed for quick data entry on both the handheld and your Windows
desktop machine. As you compose your outline and finish one item, type (or graffiti)
a return to start the next item. The new item will be inserted at a level that is
appropriate for the current state of the outline.

The handheld application has 2 toolbar icons for inserting new items. One inserts a
new sibling item, and the other a new child item. The items are inserted based on
the current location of the input caret.

On the desktop, Shift-Enter will give priority to inserting the new item one level below
the current item. On the Palm device, the New Child menu command will create a
new child item under the current item.

There is a preference that controls the type (Simple, To Do, Task) given to new
items. When starting a new outline, it is best to configure this preference for the
most common type of item that will be added to the outline.

If you paste text from another application that is composed of several lines, Bonsai
will create an item for each line of text.

j Note:

If an active filter will hide a new item, the filter is cleared so the new
item will be shown.

2.3.2 Expanding and Collapsing

Tap on the triangle symbols to expand and collapse that branch of the outline. There
are also menu commands that will expand or collapse the current item, or the entire
tree. Tap on the outline icon to display a pop up menu of expand levels.

© 1999-2006 Natara Software, Inc.
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‘Outline Hierarchy IIAGILGAS

€ 1. This item has no children
P 2. This is a parent

R EEAAERN

¢ 1. This item has no children
D 2. This is a parent
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2
3
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4
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‘Outline Hierarchy IIAGILGAS

¢ 1.[This item has no children
W 2. This is a parent
¥ 2.AThis is a child and parent item.
¢ a. This is a child
¢ b. Asecond child item
¥ 2.B This parent is collapsed and
hides the children items.
¢ a. This child was hidden

l a2 =D9

Bonsai saves the expand-collapse state of the outline so that it will open to the same
state the next time it is viewed.

2.3.3 Moving Items Up and Down

When dragging a branch, the highlighting of an item indicates that the branch would
be dropped as the last child of that item, and an insertion bar indicates that the item
will be dropped as a sibling. When dropped as a sibling; if the item above the
insertion bar is a parent of the item below, the branch will be dropped as the sibling
of the item below the bar (which is also the first child of the parent above the bar).
Otherwise, it is dropped as the sibling of the item above the insertion bar.

When dragging, you can scroll the view to an off screen location by positioning you
stylus at the top (title area) of bottom (button area) of the view. The desktop
application also supports Alt-Shift-Up Arrow and Alt-Shift-Down Arrow to move items
up and down within their siblings.\

Holding down the Control key when dropping a branch will perform a copy operation,
instead of a move. A plus sign is displayed with the drag cursor during a drag copy.

2.3.4 Indenting Items

Tab and Shift-Tab can be used to quickly change the indentation of an item. This is
the quickest way to change indentation when using a keyboard. The desktop
application also supports Alt-Shift-Left Arrow and Alt-Shift-Right Arrow to change the
indentation.
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When using a stylus or mouse, tap/click and hold as with vertical dragging, but shift
the item in or out. With the Palm application, the next-field, previous-field graffiti
strokes also change the indentation of an item.

The Windows application uses a vertical line to show the indentation level. The
Palm OS application will redraw the item as it is shifted.

‘Outline Hierarchy IIAGILGAS

¢ 1. This item has no children
W 2. This is a parent
¥ 2.AThis is a child and parent item.
¢ a. This is a child

¥ 2.B This parent is collapsed and
hides the children items.
< @. This child was hidden

IR EERRAERD

On the desktop, a vertical line is drawn to indicate the indentation level for the drag.
A box is drawn on the line to indicate the branch being indented. In the example
below, 2.B will be indented and become 2.A.3.

Outline

+ 1. This item has no children
w 2. Thisis a parent

- 2_1 This is a child and parent item.

i 2.A.1 Asecond child item
4 + 2.A.2 Thisis a child
w23 This parent is collapsed and hides the
hildren items.

T 2.B.1 This child was hidden

" Outline Hierarchy

2.3.5 Managing the Hierarchy

Both the Palm OS and the Windows applications support the management of the
hierarchy through dragging and cut-paste operations. To drag a branch, tap and
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hold on the expand symbol or diamond and drag the items. During a drag on with
Palm OS application, a box is drawn around the branch being moved.

‘Outline Hierarchy IIAGILGAS

¢ 1. This item has no children
W 2. This is a parent
¥ 2.AThis is a child and parent item.
¢ a. This is a child
e D Asecond childitem
¥ 2.B This parent is collapsed and
hides the children items.

< @. This child was hidden

IR EERRAERD

When using cut-paste, tap on the item's text so the insertion caret is on the item to
be moved. Then use the menu Cut Branch or Copy Branch commands.

On the desktop, a line is drawn to show where in the outline the item will be moved.
A small box is drawn on the line to indicate the level at which the branch will be
inserted.

Outline

+ 1. This item has no children
w 2. Thisis a parent

T Eé‘x This is a child and parent item.

M ¢ 2A1 A second child item

b + 2A2 Thisis a child
w 2B This parent is collapsed and hides the
children items.
+» 2. B.1 This child was hidden

[ Qutline Hierarchy

In the above example, the branch will be inserted as a child of 2.A.
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3.1

3.2

Bonsai Outliner for Windows

This topic describes the Bonsai outliner application for Windows.
Starting Bonsai

Double-click an existing outline file, or select Bonsai from the Natara Software group
on the Windows Start menu.

& jy Outlines EIIE[?I
iy

Fle Edt Vew Favortes Took Help

F

Qe - ©  (F Osewch [ roders [T | [ Foider syme

Address | Dy \Projects My Outlines b Ga

o s | Personsl Tacks
File and Folder Tasks v Eors thre Q 2l Outhne
£ Make a new foider :

Publish this folder to
a the Web

3 objects 290 KB o My Computer

The first time Bonsai is run is will start an empty outline. After the first time, Bonsai
will restore the outlines that were open the last time it was run. Bonsai can have
several outlines open at once.

Bonsai can also be run from a command line to import or export an outline.

Desktop Main View

This is the view of an outline on the desktop. The view of the outline is customizable
using the Preferences dialog.

© 1999-2006 Natara Software, Inc.



Bonsai Outliner for Windows 29

3.3

Title bar with outline name

‘% Natara Bonsai - [Remodeling*]

Q Fle Edit View Item Qutline Window Help -8 X
=] = 2N [T M
Toolbars _'jlﬁ@m D’ﬁ ﬂ j @ a0 J _1 T g@
@ = A v e
Current ltem I{I':I = 1 2 3 4 A" ./+ 'd ﬁ @ﬁ ? ? ZJr s {_
Indicator HW Outline ] ] Due €—= Column head
Outline Name } | E=mKitchen = 11/10/2004
—| P Busi + o Install cabinets =4 1 1/6/2004
tlom grab E% P+ o Install counters 1 1/7/2004
Callsto + o Install sink B 11/10/2004
Qutline + Qchentweb projec + & Paint @ 1 1/7/2004
Manager e S_— 7 ECFinishtrim & 171122005
+ o First stain coat 11/31/2004
Q’D‘SP'EY—” + & Second stain coat d—— 262004 Link
= B Per + & Firstvarmish =4 17112/2005
+ o Sand B 1211/2004
Around the housq + [ Secondvarnish oo
Expand - d Q’O“H'”e Hierarehy [ note can contain more information that the item text. [ Priority
Collapse icons QRemodeling
[0 unfiled
< » Remodeling™ [ —— Note area
? ? Mot Fitered - Start: ;‘;q Due:
Ready User: Jim Tuttle Ttems: 14
Cls'glz';igll:er Outline tabs Status bar with current user name

By clicking in the selection gutter you can select multiple items to operate on.

Right-click on the column header to select columns for display.

When the mouse moves over the link or note columns information about the link or
note is shown in a pop up window.

An asterisk is appended to the outline name in the title bar when the outline has
been modified.

Selecting Multiple Items

The desktop application supports selecting multiple items. Click on the selection
gutter to select an item. The item will be highlighted. Use Ctrl-Click and Shift-Click
to expand the selection. Operations can then be done on all the selected items.
Use the commands on the menus, or right-click for context menus.

You can also select all the siblings of the current item using the command on the Edit
menu or Alt+A.
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3.4

‘% Natara Bonsai - [Remodeling®]
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Four items in the outline have been selected in the example above. The category of
all four items could be set by selecting a new category from the Item menu.

Zoom in on a Branch

Bonsai has the ability to zoom in on a branch. Only the children of the single branch
are shown. The Zoom Out command returns to the original view.

In this example notice how the tab is updated with the name of the zoomed branch.
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Outline

+ 1. This item has no children
w 2. Thisis a parent
w 2.A Thisis a child and parent item.
+ 2 A1 Asecondchild item
4 + 2A2 Thisisa child
w 2.B This parent is collapsed and hides the
children items.
+ 2. B.1 This child was hidden

[ Outline Hieranchy™

Qutline

+ 1 A seclond child item
¢ 2 This is a child

[ Qutline Hierarchy: This is a child and paren...”

3.5 Item Details

Besides its title each item has an additional set of attributes. When not displayed on
the outline view the attributes can be viewed and set on the details dialog. Alt-Enter
displays the details dialog for the current item. The following topics cover each tab of
the details dialog.

3.5.1 General Tab

The General tab contains the item type, category, and priority and completion status.
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3511

3.51.2

Details

X

General | Dates | Links | Tet || MNote

Type:
) Simple # To Do ) Task
[ ] Parent of Next Action items

Priorty: |2 w

Category: | Unfiled w

Completed: [ ]

Cost: 0.00

[ oK H Cancel ]

The information shown on the General tab is dependent on the item's type. Simple
items do not have a completion status.

Type

Each item in an outline is one of 3 types: simple, to do, and task. The type assigned
to an item when it is added to the outline is controlled by a preference. The type can
then be changed from the details view.

A Simple item can be changed to either a To Do or a Task by tapping (or right click)
on the status icon and selecting the type from the pop up menu. With the desktop
application, right click on the completion status to display the item type menu.

Status

Items of type To Do and Task have a completion status. To do's are either done, or
not done. Tasks have a completion status between 0% and 100%. The status can
be set directly on the details dialog. The hard scroll buttons will change the percent
complete of a task by 10% for each press.
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The status of an item can also be set from the outline view when the completion
status is shown (a preference setting). Tap (or left click) on the progress bar and
drag left and right to change the percent complete.

On both the desktop and Palm device, command and shortcuts are provided that
toggle the completion status

When you change the completion status of an item, the completion status of its
parent items is recalculated. A preference setting is available to disable this
behavior.

3.5.1.3 Priority

Each item has a priority from 1 to 5, or no assigned priority. Priority 1 is considered
the most important. You can filter the outline with a priority. The priority of an item
can be set from the outline view when the priority is shown (a preference setting).

The priority assigned to new items can be set in the preferences.

3.5.1.4 Category

Categories provide a customizable attribute that can be used as desired. Each item
in the outline can be assigned to a category, or left unfiled.

The outline can be filtered on category. For example, you could use the categories
with a To Do list to indicate the best time of day to perform the work. You could then
filter your To Do list on time of day.

j Note:

There is a 15 user-defined category limit for compatibility with
handhelds using the Palm OS.

3.5.2 Dates Tab

The Dates tab has the dates for items with a type of To Do or Task.
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3.5.21

3.5.3

X

Details

General | Dates | Links | Tet || MNote

Created: |1/6/2004|

Start: |12/14/2005
12/16/2005 '+
Completed: |12/15/2005 +

Due:

1]

| ok || cancel || ety || Hep |

The dates of parent items can not be modified if the option to roll up dates is
configured.

Dates

Items of type To Do and Task also have a Start, Due and Completion date. When a
To Do is checked completed, or a Task is marked 100%, the completion date is set
to the current date. The completion date can also be manually set to another date.

Besides the ability to select a date from the calendar, the context menu has several
quick dates. The entries on the menu are specific to the start, due, and completion
date uses.

When you change the date of an item, the dates of its parent items are recalculated.
A preference setting is available to disable this behavior.

Links Tab

An item can be linked to either another Bonsai outline, an event in the date book, or
a standard To Do. Links can be set in the details dialog of an item. Tapping on the
link icon will jump to the to do, event, or outline.

An item can also be associated with a contact name. Bonsai will auto-complete this
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field with names from the build-in address book. However, you can put any text in
this field.

One or more keywords can be assigned to the item. Keywords are selected from the
keyword dialog.

Details [‘S__<|
General | Dates | Links |Te:d Mote

Link:
) None ) To Do ) Calendar (&) Outline

|F|.rc:und the house w |

Contact: |5m'rth.Jane v|
Kewwaords:
@Home |
Add
oK || cancel || Appy || Hep

3.5.3.1 To Do Links

Setting a to do link can be done from the details dialog.

When an item is linked a new To Do is created in the built-in To Do database using
the attributes of the item (Name, Note, Priority, Due Date, Completion Status,
Category).

If there is a category in the standard To Do database that matches the category of
the item in the outline, the linked to do will assigned that category. Otherwise, the to
do will be assigned the unfiled category.

Tapping on the To Do link icon will jump to the To Do. The application launched is
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configured in the Settings dialog. Bonsai can insert a link tag into the To Do to
indicate that the To Do is associated with a Bonsai outline. Configuring this option is
also done in the Settings dialog. When link tags are used it is possible to jump back
to the Bonsai outline from the To Do application. Instructions for installing and
configuring this option are given in the Back-2-Bonsai topics.

Details §|

General | Dates | Links | Text || Note

Link::
) None () To Do ) Calendar () Outline
Cortact: |Smith.Jane "

Kewwaords:
@Home

oK || cancel || Appy || Hep

Unlinking the item, or changing the link type to outline, will break the link to the To
Do. The To Do is removed from the standard To Do database if the application
setting is enabled for this option.

@ Note: Changes made on the desktop to an item linked with a To
Do require 2 synchronizations before they appear in the desktop PIM
application. On the first synchronization the changes are propagated to
the handheld To Do database. On the second synchronization the
changes are propagated to the desktop PIM application by the PIM
HotSync Manager conduits.
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3.5.3.2 Outline Links

Linking an item to another outline is done in the details dialog. The name of the
linked outline will be displayed below the link selection. Tapping on the outline link
icon (the tree) will jump to the linked outline.

Details [5__(|
General | Dates | Links |Tead Mote

Link::
{3 Mone {(3To Do Calendar () Outline

|.ﬁ.rc:und the house L |

Contact: |5m'rth.Jane

vl
Kewwords:
ZHome |
Add
Lok J[ Concel J[ ey [ Heb |

The link can be thought of as a master project to subproject link. The link points to
another outline, and not to an item. Changing the selection will break the link to the
other outline.

3.5.3.3 Keywords

One or more keywords can be assigned to an item. Keywords are useful when
filtering an outline. Icons can be assigned to keywords.
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General | Dates | Links |Te:d | Note |

Link:
) None ) To Do ) Calendar (&) Outline
|Pmur1d the house w |
Contact: |Sm'rth.Jane v|
Kewwaords:
@Home |
Add
| ok || cancel || Moty || Hebp

You can assigned multiple keywords to an item on the desktop in one operation.
Click on the Add button to display the Select Keywords dialog. Select each keyword

to be added to the item and click OK.
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Select Keywords R|

Al v

{@Horme : Location

®

oK |

D

reork : Location

)

Apples : Candy
Bonsai : Projects
Cheese : Candy
DayMotez : Frojects

| Cancel |

%
¥ 3
9
&

Saw Materials
Sizzors : Materials
hammer : Materials
mars bar : Candy
saw ; Materials

Mlew Keyanard

Edit Keyword

g~ hec

Delete Keyward(s)

[ |Replace current keywiords with selection

By default the keywords will be appended to the item's existing keywords. By
checking the replace option, the existing keywords will be removed before added the
new keywords.

You can also assigned keywords to multiple items in an outline in one operation.
Select all the items using the selection gutter and select Keywords from the Item
menu.

3.54 Text

An alternative way of editing the outline text is the Text tab of the details dialog.
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| General | Dates | Links | Tead |Nate |

A second child tem

oK || cancel || Appy || Hep

3.5.5 Notes

Tap on the note button to display and edit the note. Each item can have a note up to
32K.
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| General | Dates | Links | Text | Note |

This is a note for an item in the outline.

Motes are useful for holding detailed information an an
item.

| ok || cancel || Moty || Hebp

A note icon can be displayed on the outline view to show what items have notes.
The note for the current item (where the caret is displayed) is shown in the window.

© 1999-2006 Natara Software, Inc.



42

Natara Bonsai User Manual

3.6

‘' Natara Bonsai - [Outline Hierarchy] E|[E|E|
Q File Edit View Item Outlne Window Help -8 X

1288 3SADP ¥ 59 9- ]
=4+ 12 3 4Al 2, BRDDPL 4

Qutline
+ 1. This item has no children
w 2. Thisis a parent
w 2.A Thisis a child and parent item.
3 + 2.A1 Asecond child item EA
+ 2.A2 Thisis a child <)
w 2.B This parent is collapsed and hides the
children items.
+ 2. B.1 This child was hidden

" Outline Hierarchy |
Start: | 12/14/2005 3 E Due: | 12/16/2005 3 E ol E
% ? Mot Filtered -
Ready User: Jim Tutte 1
Keywords

Bonsai maintains a single list of keywords that is shared by all outlines. When adding
keywords to items in an outline this list is displayed. Keywords are assigned to
categories for grouping.

The keyword list is global to all outlines. Keywords are inserted into outlines as text,
and not as references to the global keyword list. Changes you make to the global
keyword list are not reflected in the outlines.

Icons can be assigned to the keywords. The icons can then be displayed in the
outline instead of the keyword text.

Keywords for items are shown on the Links tab of the details dialog.
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Edit Keywords E|

All i

{@Home : Location
{@Work : Location
Apples : Candy
Bonsai: Projects
Cheese : Candy
DayMotez : Frojects
George

o Materials

Lo |

Sizzors : Materials Mew Keyword

hammer : kMaterials
Edit k. d
mars bar: Candy T FE24A 0T

saw : baterials

idefec R EPePI

Delete Keyvword(s)

When all keywords are shown (see desktop example above), the category is
appended to the keyword for display. When a category is selected, as with the
handheld example, the category is not appended to the keyword.

Edit Keyword

Feynord: | Ok |
C I
Categary: |Materials w | ance |
lcon: | = Change lcan
| Edit Categaories |

23

Note:
During synchronization the most recent set of keywords (desktop or
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3.7

3.7.1

handheld) is copied over the other set. For this reason, perform
keyword maintenance on one side between each synchronization.

Filter the View

Bonsai supports the ability to filter the items that are displayed. To access the dialog
to create new filters or edit existing filters; tap the filter drop list in the upper-right of
the handheld screen, or click on the edit filter icon on the desktop application.

Several attributes can be filtered at one time. Only items that match all the selected
attributes will be displayed. For example, it is possible to filter for priority 1
incomplete items from the business category.

An existing filter can be enabled by selecting it from the filter drop-list.

”\}' ? Mat Filtered .

Ready

j Note: The current filter is automatically disabled if none of the items in the
outline match the filter.

Filter List

Select a filter to use, or create and edit filters from this dialog.

If you have create a set of filters in another outline that you would like to reuse, use
the Import option to copy them into this outline.

Select Use Filter to activate the selected filter.
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@5 haw Incomplete - fat
+hny Contact
Completed items
Qverdue Items

Infiled items

Ize Filter
Dore
Edit...
Celete
Mew

[rpart. ..

3.7.2 Filter Definition
The filter definition is divided onto several tabs.
3.7.2.1 General

The first tab contains the filter name and several filter criteria.

45
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Edit Filter

General |Optiuns Dates | Categories | Keywords

X

Name: |Jim's Tasks

Status: | Any Status

v

Type: |.P|.II Types

v

Priority: | Al Priorties

v

Link: | Link Filer (OFF)

v

Texd: ||

[ ] Also search notes

oK || cancel | Help
The following filter attributes are on this tab.
Filter Attribute Description

Name Assign a name to the filter to describe its action

Status Filter to do's and tasks based on the completion
status.

Type Filter on item type; Simple, To Do, and Task.

Priority A number of options to filter on priority.

Link Filter based on whether the item is linked or not.

Text A string to search for. Check the Also search notes
option to search for the string in notes.

Attribute When checked only these items are included

3.7.2.2 Options

This tab contains options that affect the overall filter results.
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Edit Filter

General | Options

Flat

Sorted by:

Scope

Mext Action Parerts
Limit view to Mext Action tem for Mext Action branches

Display results as a flat list

(%) Apply fitter to every item in the outline
(" Hide entire branch when a parent does not match filtter
) Include entire branch when parent matches filter

[ ] Reverse Filter Action

3

Dates | Categories || Keywords

Based on: | Start Date w

Teadt ~ | [ ]Descending

| ok

==

The following filter attributes are on this tab.

Filter Attribute

Description

Next Action Parents

When the "Limit view..." option is selected Bonsai will
select a single child item to display for parents with
the Parent of Next Action Items attribute. The order
used for ranking the children can be selected here.

Flat When this option is checked the results of the filter
are displayed as a flat list.
Scope By default the filter is applied to all items in the

outline. There are two options for limiting the filters
use.

Reverse Filter Action

When this option is checked Bonsai will reverse the
results of checking the filter against a single item.

Attribute When checked

3.7.2.3 Dates

only these items are included

This tab contains date and contact filtering options.
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| General || Options | Dates |Categuries | Keywords |

EETTI | [ /132004 v

Start date:

Due date: |Toda"_.r W |

Completed Date: | Completed Within v | | 1| dayls)

Contact: |Sm'rth Jane "

[ ] Match any contact name

oK || cancel Apph Help

3.7.2.4 Category

This tab contains category filtering options. The filter will only include items whose
category is checked.
Bonsai will not let you define a filter without at least one category checked.
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3.7.25 Keywords

| General || Options | Dates | Categories | Keywords |

Select categories:

Business
Ertertainment

49

OK

l [ Cancel

Help

This tab contains keyword filtering options. Since you can include more than one

keyword in the filter, there is a set of options that affects how the keywords are

matched.
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3.8

3.8.1

Edit Filter X

General | Options | Dates Categuries| Keywords

Selected keywords:

EHome
(George

[T% 4

Show items that have: | All of the selected keywords w

oK || cancel Help

Preferences

The preferences dialog is available from the File menu. Note that each outline has
its own set of preferences. Be sure to have the correct outline open when you
modify the preferences.

The initial value for the preferences is taken from a set of defaults. The section
following this describes how to change those default preferences. The preferences
are grouped onto tabs.

General

This tab has general display and numbering options.
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Outline Preferences

General |Ea|u:ulated Mew ltems || Categores | Columns | Colors

Mumbering:
Level 1: v Level 5: | Mone v

Level 2. [A, B, C |» Level &: | Mone w
Level 3: (1,23 w Level 7: | Mone w

Level 4: | Mone W Level 8: | Mone W
Show Al Mumbers To Level: |3 W
Show in Outline:
[ ] Show Completion Status (checkboxes, progress bars)
[ ] Show Pricrity
Show ltem Selection Gutter
Show Mumbers

I

elp

oK || cancel

3.8.2 Calculated

This tab has options that control the calculation of parent values from children. When
the option is checked the value of the parent will be calculated from its children.
There are three options.

Completion Status

Check this option to calculate the percent complete or check box status from the
children items.

Dates

Check this option to calculate the Start, Due and Completion dates from the children
items. The start date of the parent will be the earliest child date. The due date and
completion date of the parent will be the latest date of the children.

Custom Numeric Field
Check this option to calculate the parent's custom numeric value from the children
items. There are several options for the calculation.
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Outline Preferences b_<|

General | Calculated | New ttems | Categories | Columns | Colors |

Calculate Parent Walues from Children:

Completion Status (checkmark or percentage)
Start, Due and Complete dates

Custom numeric field

| Sum ~ | Al children v|

oK || cancel Apph Help

3.8.3 New Items

This tab contains options for new items.
For details on the options, see the New Items tab of the handheld preferences dialog
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Outline Preferences ['5|

| General | Calculated | Mew tems | Categories | Columns || Colors |

Default attributes for new tems

Type:
Pricirity:
Start Date: | ygne

Due Date: | pone

Category: | parent's
Keywords: | None

Autodink To Da:

D —_—
C O I 0 I 0 I S

oK || cancel Apph Help

3.8.4 Categories

Edit the categories of an outline on this tab. Click the Icon button to select the icon
for the category using the Select Icon dialog.
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Outline Preferences E'
| General | Calculated | New ftems | Categories |Culumr15 | Colors |

Business =

Entertainment =

Garden w

)

Sports -+

Fename...
oK || cancel Apph Help

3.8.5 Columns

The Bonsai desktop application has an addition preference page. The desktop
application can display item attributes in columns. Use this preference page to
select the columns to be displayed.
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Outline Preferences E'

General | Caleulated | New tems Categuries| Columns | Colors

Awailable Dizplayed
% Complete Add > ftem
geglnr'_f 5 Outline text
mplete Mote
Contact
Created Due
Custom
T i Due
Keyword lcons
Kaywords
Linked
Priority
Start
Status

Custom label: | Cost

[ ] Save as default columns for new outlines

| ok || cancel || ey || Heb

The columns can then be arranged and sized by dragging them in the outline
window.

3.8.6 Colors

This tab is used to define a coloring scheme for an outline. The "Color by" selector
has a list of several attributes. They include; Category, Priority, Outline Level, and
Due Date. Tap on the color box to display the color selection dialog.

Bonsai will remember a color scheme for each Color By selection.
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3.9

Outline Preferences

General | Caloulated | New tems | Categories | Columns | Colors |
Color by Attribute
Color outline by: | Due Date v|
B o ouevate | BT
| I L
B o compieed
B o276 | |
B osomorn
B 0wty | ]
[ esesensy [
ﬂ 27 overdue !
J ] Completed tems
Lok J[ Camcel J[ Ay [ e

New Outline Defaults

Each outline has its own preference settings that determine how it looks and
behaves. Once an outline is created, these settings can be modified without

affecting other outlines.

Bonsai has a set of initial preferences that are given to all new outlines. A separate
set of defaults is available on both the Palm device and the desktop.

Use the New Outline Defaults command on the View menu to display the default

settings for new outlines.
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Defaults for New Outlines

General | Calculated | New lems | Categories | Colors |

Mumbering:
Level 1: v Level 5: | None v
Level 2: (1,23 w Level &: | Mone w
Level 3: (1,23 w Level 7: | Mone w
Level 4:11,2,3 A Level 8: | Mone A

Show All Numbers To Level:

Show in Outline:

Show Completion Status (checkboxes, progress bars)
[ ] Show Pricrity

Show ttem Selection Gutter

Show Mumbers

QK l [ Cancel Appih

I

elp

3.10 Settings

The Settings dialog has 6 tabs;

e General

e Colors

e Font

e Export

e Printing

e Synchronization

3.10.1 General

This is the general tab of the settings dialog.
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Bonsai Settings

General |Culur | Fonts || Export | Printing | Synchronization |

[ ] Ertter key splits item text into two items

[ ] 5ot Mo Date to the end of list

Show Simple tems when fitering on status.
] Show naotes on right

[]Use M5 Cffice 2003 lock and feel

Outline tabs

Large toolbars

Show tooltips for icon columns

Append space after inserted date/time

Week starts on: | Maonday w |

oK | cance | = fom
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3.10.2

Setting

Description

Enter splits item text

When unchecked, a return graffiti stroke or enter key will start a
new item without changing the item where the caret is placed.
When checked, the title of the current item is split at the caret
location to create the new item. This operation is similar to a word
processor.

Sort No Date to end of list

Controls how the 'No Date' value is sorted in relation to other dates.

Show Simple items when
filtering on status.

Normally, a simple item will not match a filter that uses an item
status since it does not have a status. Check this option to cause
Simple items to match any status filter state.

Show notes on right

Controls whether the notes pane is shown on the bottom or the
right of the window

Reapply filter while editing

When checked, causes Bonsai to be very aggressive with an active
filter. As an item is modified, it will disappear immediately if it fails
to match the filter.

Use MS Office 2003 look and
feel

Bonsai supports 2 styles; MS Office 2003 and XP.

Outline tabs

When checked, Bonsai will display tabs for all the open outlines.

Large toolbars

Check this option to use a larger set of toolbar icons. This is useful
on some screen resolutions.

Show tool tips for icon
columns

When checked Bonsai will display a tip pop up when the mouse is
moved over a category or keyword icon.

Week starts on

This setting affects filter operation for options that deal with end of
week, or a week range. It also affects the display of month calendar
dialogs.

Append space after inserted
date/time

When checked Bonsai will insert a trailing space when using the
insert date or time commands.

Colors

This tab has the settings for several colors used in the outlines.
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Bonsai Settings

General | Color | Fonts | Export | Printing | Synchronization |

. Color for parent items that do not match active fiter

. URL text color
. URL howver tesd color
. Color for calculated custom values

QK ] [ Cancel Apph

3.10.3 Font
This is the font tab of the settings dialog.
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3.10.4 Export

Bonsai Settings

| General || Color | Fonts | Export || Printing | Synchronization |

Font for Outline Text
Font for Outline Text

Fort...

Font for Notes

ok || Cancel

The export tab contains options used during an export operation.

61
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Bonsai Settings

General | Calor

Include these fields in the exported file:

[ ] Mumbers []Category
[ ] Completion Status Motes
] Pricrity Put notes at bottom
Dates
[]5tart []Due [ ]Completed
Al » | Include this outline level and above
Apply cument fitter to export
¥ML Export

Include DTD reference
[]Include X5LT reference

X

Fontz | Export | Prirting | Synchronization

OK

] [ Cancel

Setting

Description

Include these fields in the
exported file

Check the attributes that should be included in the export. These
options only effect the standard export command, and do not effect
template exports.

Include this outline level and
above

To restrict the amount of details included in the export, select the
lowest level to export here.

Apply current filter to export

When checked, only items that pass the current filter are exported.

Include DTD

When checked, a reference to the Bonsai data type definition file
will be included in the exported XML file. This is only applicable to
the fixed XML export format.

Include XSLT reference

When checked, a reference to an XSLT file is included in the
exported XML file. This is only applicable to the fixed XML export
format.

3.10.5 Printing
This is the printing tab of the settings dialog.
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Bonsai Settings

General | Calor

Include notes

[ ] Print in Black & White

] Onty print the Outline column
Include page numbers

Printer Font for Outline Text Fart...

Printer Font for Outline Notes

X

Fontz | Export | Prnting | Synchronization

o) [ ced

Setting

Description

Include Notes

Check this option to include the notes into the printed output.

Print in Black & White

Some print drivers do not properly handle the color bitmaps used by
Bonsai for icons. If this is the case with your printer, check this
option.

Only print the Outline column

By default, Bonsai prints the outline as it appears on your display. If
you only want to print the outline itself, and none of the other
displayed columns (dates, note icon, link icon, etc), then check this
option.

Include page numbers

Check this option to include the page number at the bottom of each
printed page.

3.10.6 Synchronization

There are several other miscellaneous options on the Synchronization tab of the

Settings dialog.
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Bonsai Settings

Genersl | Color | Forts || Export | Printing | Synchronization

Show Progress During Synchrmonization
[+] Abwarys ek haredbald Ta Do databass for changes

Dk location for new outlines
D\ Projects D

Logging during synchronization: | Standard v

Post synchonization command:
|
Lok J[ Conced J[ Aot |[ Heb |
Setting Description
Show Progress During When this option is checked, the Bonsai conduit displays a
Synchronization dialog during synchronization that shows what step is being
preformed.

Always check handheld To Do When this option is checked, the Bonsai conduit will
database for changes compare the standard handheld To Do database against

any outlines that contain To Do links even if the outline has
not been modified on the handheld or desktop. If there are
a large number of outlines that contain To Do links, this can
slow down the synchronization.

Logging during synchronization This setting determines the amount of information written to
the HotSync Manager log file on the desktop.
Post synchronization command A command line in this field will be executed after the

Bonsai conduit completed synchronization. The command
line should include a full path to the program to be
executed.

3.11 Spell Checker
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3.11.1 Spell Checker Options

This dialog is used to configure the Spell Checker. The dialog is accessed from the
View menu.

Bonsai is installed with the US English dictionary. To download other dictionaries
select Dictionaries from the Help menu. Place the downloaded dictionaries in the
Bonsai installation folder.

Spell Checker Options

Spell Checking

Speling

Check speling as you type

Alwans zuggest comections

[] Suggest from main dictionaries anly
lgriore words in IPPERCASE
Ignore words with numbers

Ignare intermet and file addreszes

Custom dictionary
Bonzai.dic w

b ain dictionaries

Eon U5

k. l [ Cancel

23

Note: The Check spelling as you type feature is only available in
the Notes pane and Note and Text tabs of the Item Details
dialog.

3.11.2 Auto-Correct Options

This dialog is used to configure the Auto-Correct features.

© 1999-2006 Natara Software, Inc.



66 Natara Bonsai User Manual

AutoCorrect |E| [z|

AutoCorect |

[] Comect Two IMitial Capitals

[ ] Capitalize first letter of sentences

Correct accidental usage of Caps Lock key
Replace text az you type
Autamatically add words to escephion list

Replace: With:

k. ] [ Cancel

23

Note: The Replace text as you type feature is only available in
the Notes pane and Note and Text tabs of the Item Details
dialog.

3.12 Toolbars and Shortcuts
3.12.1 Toolbars

There are several toolbars on the desktop application. The toolbars can be shown
on hidden using the View Toolbars menu.

The contents of each toolbar include;

Standard Toolbar

NFEREEY 5@
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e New outline

e Open outline

e Save outline

e Save all open outlines

¢ Close all outlines

e Display Bonsai Settings dialog
e Change current HotSync User
e Display Outline Preferences dialog
e Print the outline

e Print Preview

e Display the user manual

Edit Toolbar

2B - 2O

e Cut highlighted text

e Copy highlighted text

¢ Paste text

e Undo, with drop arrow of undo actions
e Insert date

e Insert time

Outline Toolbar

R0/ 0P2 €93 ¢+ v FHHX

e Display Details dialog for current item

e Find

e Enable last used filter or disable current filter
e Display filter dialog

e Sort

e QOutdent

e Indent

e Indent branch

e Move branch up (before previous sibling)
e Move branch down (after next sibling)

e Cut branch

e Copy branch

e Paste branch

e Delete branch

67
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Expand / Collapse Toolbar

wr=4# 12 3 4 Al /H -

e Expand current branch

¢ Collapse current branch

e Expand entire branch

¢ Collapse entire outline

e Collapse to level 2 items

¢ Collapse to level 3 items

¢ Collapse to level 4 items

e Expand entire outline

e Zoom in on current branch
e ZOoOm out

Filter Toolbar

D NotFilered .

Ready

The filter toolbar displays the currently active filter and has a drop list to select a
filter.

Dates Toolbar
Start: | 12414/2005 v E Due: | 12642005 v E Complated: | 12/15/2005 v E

The dates toolbar displays the dates for the current item. There is an icon next to
each date for clearing that date.

3.12.2 Shortcuts

The desktop keyboard shortcuts for Bonsai are as follows.

Delete Delete selected text, or character after cursor.
End Move cursor to the end of the item title.

Enter Insert an item into the outline.

Home Move cursor to the start of the item title.
Keypad '+' Expand the current branch.

Keypad *-' Collapse the current branch.

Tab Indent the current item.

F1 Display help.
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F3 Open the Find dialog.

F5 Toggle the completion state of the current item.

F6 Switch between outline and notes pane.

F7 Spell check

F8 Sort

F9 Insert a file link.

F11 Hide and show the item selection gutter.

Shift + Delete Cut the selected text to the clipboard.

Shift + End Expand selection to end of item.

Shift + Enter Insert an item into the outline as a child of the current
item.

Shift + Home Expand selection to the beginning of the item.

Shift + Insert Paste the text from the clipboard into the current item.

Shift + Keypad '+' Expand all branches.

Shift + Keypad '-' Collapse all branches.

Shift + Left Expand selection to include previous character.

Shift + Right Expand selection to include next character.

Shift + Tab Outdent the current item.

Ctrl+0 Set priority of item to None.

Ctrl+1..5 Set priority of item from 1 to 5.

Ctrl + A Select the entire title of the current item.

Ctrl + B Cut the current branch.

Ctrl+ C Copy selected text to the clipboard.

Ctrl + D Insert current date.

Ctrl+ E Remove keywords from current item.

Ctrl+ F Open find dialog.

Ctrl+ G Find again.

Ctrl + 1 Set item type to To Do.

Ctrl +J Jump to linked outline.

Ctrl + K Set item type to Task.

Ctrl + L Link item with To Do.

Ctrl+ M Set item type to Simple.

Ctrl + N Start a new outline.

Ctrl+ O Display the dialog to open an existing outline.

Ctrl + P Print the outline.

Ctrl+ R Copy the current branch to the clipboard.

Ctrl + S Save the outline.

Ctrl+T Insert the current time.

Ctrl+ U Display the Replace dialog to find and replace text.

Ctrl+V Paste the text from the clipboard into the current item.

Ctrl + W Close the outline.

Ctrl + X Cut the selected text.

Ctrl+Y Paste the branch from the clipboard after the current item.

Ctrl+ Z Undo the previous action.

Ctrl + Keypad '+' Fully expand the current branch.
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Ctrl + Enter

Ctrl + Backspace
Ctrl + Delete
Ctrl + Down
Ctrl + End
Ctrl + Home
Ctrl + Insert
Ctrl + Left
Ctrl + Right
Ctrl + Tab
Ctrl + Up
Ctrl + F4
Ctrl + F7

Ctrl + Shift + L
Ctrl + Shift + S
Ctrl + Shift + Right
Ctrl + Shift + Left

Alt+1
Alt + 2
Alt + 3
Alt + 4
Alt + A
Alt+D
Alt + E
Alt +F
Alt + H
Alt + |
Alt +J
Alt + Shift +J
Alt + K
Alt + L
Alt+ M
Alt + N
Alt+ O
Alt + P
Alt +R
Alt+S
Alt+T
Alt +V
Alt + W
Alt + X
Alt+Y
Alt+Z
Alt + Backspace

Insert a line break in the outline title at the current cursor

position.

Delete the previous word.

Delete the current word.

Move the current branch after its next sibling.
Move cursor to end of outline.

Move cursor to top of outline.

Copy selected text to the clipboard

Move cursor to previous word.

Move cursor to next work.

Switch to next outline.

Move the current branch before its previous sibling.
Close current outline.

Spell check current item or current note.

Unlink item

Save All

Expand selection to include next work.
Expand selection to include previous word.

Collapse the entire outline.

Expand outline to second level.

Expand outline to third level.

Expand outline to fourth level.

Select all siblings of current item.

Delete the current branch.

Display the Edit menu.

Display the File menu.

Display the Help menu.

Display the Item menu.

Jump to the outline item using a link tag number.
Display the Jump to Link dialog.

Display the dialog to modify keywords.

Display the list of global Keywords.

Toggle the display the Outline Manager window.
Toggle the display of outline numbers.

Display the Outline menu.

Display the outline Preferences dialog.

Edit the active filter.

Display the dialog that lists filter names.

Toggle current filter state.

Display the View menu.

Display the Window menu.

Toggle the item's Parent of Next Action attribute.
Zoom out.

Zoom in.

Undo the previous action.
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Alt + Shift + Down Move the current branch after its next sibling.

Alt + Enter Display the properties of the current item.

Alt + Left Move focus to the column to the left.

Alt + Ctrl + Left Collapse the current branch.

Alt + Shift + Left Outdent the current branch.

Alt + Right Move focus to the column to the right.

Alt + Ctrl + Right Expand the current branch.

Alt + Shift + Right Indent the current branch.

Alt + Shift + Up Move the current branch before its previous sibling.
Alt + F4 Exit Bonsai.

3.12.3 Status bar
The status bar on the Bonsai desktop application displays several items of interest.
e The current HotSync User (used during synchronization configuration)

e The number of items in the current outline, and how many are selected.
e The synchronization setting of the current outline.

_Ej WJ/ l,ﬂ/ Mat Filtered i

User: Jim Tutte Items: 1 Sync: Yes

3.13 Printing

The print command on the desktop will print the outline as shown. The printed
output will always word wrap long outline text, even if word wrap is turned off. You
can expand, collapse and filter the outline to print the level of detail required.

The notes can be included in the printed output by selecting an option on the Printing
tab of the Settings dialog.
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Home Mond4
Due Contact
1 ¢ 0O 1. hi = -
2|w 2. Windows & o 2/1/2004 George
3 ¢ 0O 2.1 Family room # —  Bill
4 ¢ 0O 2.2 Dining room 2 = -
5 o [ 2.3 Kitchen i 2/11/2004
6 ¢ 0O 2.4 Master bedroom = - Jim
Some things to be done
today.
7|w¥ —3., master/bathrooms ® 8/10/2004 Jim
8 ¢+ [ 3.1 baseboards = 8/10/2004
9 ¢ [0 3.2 Broken tiles & o 8/M10/2004 George
10 ¢ 0O 3.3 Skylight's 4 = 8/10/2004
11w —4. Den -
12 ¢ 0O 4.1 Varnish chairrails 4 = -- Bryan
13w &' 5. Buy = - George
14 v mm5 1 HW [ - Jim
15 ¢ & 1. Plant for pot B - George
16 ¢ M52 stuffad i - Julian
17 ¢ 53 Pet ® - Julian

&

Note: Export templates provide a way to customize printed output.

3.13.1 From an Export Template

The Template Print command on the File menu is used to print an outline using one
of the custom Export Templates. The submenu lists all the available templates.
When you select a template from this menu, the outline is exported to a temporary
file, and then printed. The printing is performed by the application that handles the
file type of the exported file. For example, if the outline is exported to an HTML file,
Windows will direct the print request to your browser.

3.14 Outline Manager

The Outline Manager window is used on the desktop to organize and access your
outlines. The outlines listed are for the current HotSync User shown on the

status bar. Use the HotSync User command on the File menu to select a different
user.

The Outline Manager has 3 views. Right-click and select View to select between;
e Grouped by outline category.
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e Grouped by outline status of; synchronize, desktop, or missing.
e Grouped by the desktop folder.
¢ As a flat list of outlines.

The outline names are shown with one of 3 icons;

% The outline is configured to synchronize with the handheld.
The outline does not synchronize with the handheld.

ﬁ The outline is known to Bonsai but is missing from the desktop
machine.

' Natara Bonsai - [Client web projec

@ Fle Edt View Item Outline
I8l BP N
=+ 12 3 4

Outline Manager O x
Outline Name +  Location
£ unfiled
— ﬁ Personal

Q Cutline Hierarchy C:\Docume
% Around the house D:'Test Da

— E Business

é Client web project D:Test Da

% Callisto D:YTest Da

é Calgary C:\Docume

Double-click on an outline to open it. Left-click and control left-click to select
outlines. Operations are available through the context menu by right-clicking.
Operations available include;

e Open the selected outlines.

e Toggle the synchronization setting of the selected outlines.
e Set the category.

e Move outlines to another directory.

¢ Delete outlines.

e Change the Outline Manager view.

73
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3.15

3.16

Outline Manager Ox | K.
Outline Mame & | |ocation 1 ¢ 1. Thisitem has n
2| |w 2 Thisisaparent
3 - Z2A Thisisac
C:\Pocume 4)) ¢ 2A1 As
D:YTest Da 5 + 2.A2 Thi
8] w 2.B This parel
Client web project D:Test Da . . .
& children it
f + 2B1 Thi
Open
Synchronize
Category Edit Categories...
Move Business S
< Delete ’ Personal ! Ot
Start: | 12145 View ' Unfiled 4 g
D NotFitered .

Grouping Outlines

Bonsai allows you to create outline files in the directory of your choice. You can
group outlines by placing them in subdirectories with your other related documents.
When working with the Bonsai desktop application, the Outline Manager window
provides a view of your outlines.

If you need to move an outline from one directory to another, use the Move
command in the Outline Manager.

Command Line

Summary of the Bonsai Windows command line options.

no command line Bonsai displays the outlines that were open when it was
last used.
<outline name> Bonsai displays the named outline, and the outlines that

were open when it was last used.

lexport Bonsai exports an outline using an export template. The
user interface is not displayed.

/xmlexport Bonsai exports an outline in an XML format. The user
interface is not displayed.
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3.17

3.17.1

3.17.1.1

3.17.2

/import Bonsai imports information from either a CSV or XML file
and creates an outline. The user interface is not
displayed.

llinktag:<number> Bonsai displays the outline that contains the linked item

and positions the cursor to the item.

/uid:<number> An outline name must follow this option. Bonsai will display
the outline and position the cursor to the item with the
given Unique Id.

How Do | ... ?

How to perform common activities.

Create a New Outline

From within the Bonsai application, click on the new outline icon, or use the New
command on the File menu.

When you start the Bonsai application, other than by opening an existing outline, it
will automatically start a new outline.

Use the Save command on the File menu to save the outline. The file extension
given to outline files is "OTL". Bonsai creates a file association so double-clicking on
an outline file will run Bonsai.

j Note:

Although Windows supports very long file names, only the first 28
characters of the file name will be used when naming the outline on the
Palm device.

Using Another Outline

Open the outline file you use as a template. Use the Save As command on the File
menu to make a copy of the template. You can also copy outline files to create new
outlines.

Move Items to Another Outline

Use the Cut Branch - Paste Branch, or Copy Branch - Paste Branch operations to
move items from one outline to another.
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3.17.3 Delete Items

To delete an item, position the caret in the item's title and use the Delete command
from Item menu. You can also use the Cut Branch command from the Edit menu or
the Cut Branch icon displayed on the bottom of the screen.

If you backspace (or Del) on an empty item, the item is deleted.

The last item in the outline cannot be deleted.

j Note:

Deleting a parent item will delete the entire branch.

3.17.3.1 Delete Completed Items

A command is available on the Outline menu to delete all completed items from the
outline.

If all the items in the outline are deleted, a new item is added to the outline.

Items in the outline with the Simple type, which does not have a completion status,
are not effect by this command.

j Note:

If a parent is marked complete, the entire branch will be deleted even if
some of the child items are not marked complete, or are Simple items.

3.17.4 Delete an Outline

Use Bonsai's Outline Manager window to delete outlines. Select the outlines that
you want to delete and right-click. Select one of the options from the Delete
submenu. There are 4 options.

e Delete on Desktop and Handheld
The outline file is immediately deleted from the desktop. During the next
synchronization the outline will be deleted from the handheld.

e From Desktop
The outline file is immediately deleted from the desktop. During the next
synchronization the Synchronize with Desktop option is unchecked on the
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handheld.

e From Handheld
During the next synchronization the outline is deleted from the handheld.

e Forget
The reference to the desktop outline is removed from the Outline Manager.
This is useful if a temporary outline was opened and now appears in the
Outline Manager. Or, if an outline belongs to another HotSync User and you
do not want it appearing under the current user.

Outline Manager Ox | .. Ouwl
Outline Name 4 | Location 1 + 1. Thisitem has nocC
— [ Business 2| |w2 Thisisaparent
. Open 3 w 2.A Thisis a chils
badCelg o - 4 ) + 2A1 Asec
My caig  Synchronize 5 ¢ 2A2 Thisis
écnen Category 4 i) ¥ 2B This parent i
Move children item
— _| Personz - P = |
%A Delete Delete on Desktop and Handheld
gulll|
View r Erom Desktop
éﬂuﬂl.._..._._._., e
e From Handheld
Unfile
— Forget
L4 > Outline |
Start: | 12/14/2005 v E Due: | 12/16/2005 v E Comp

3.17.5 Rename an outline
Right-click on the outline icon in the Outline Manager window and selected Rename
from the menu.

Outlines that are synchronized with the handheld will be renamed on the handheld
during the next synchronization.

3.17.6 Sort

Both platforms support sorting branches by any of the item attributes. The outline
can be sorted by 2 attributes, so that if items are equal on the first attribute, the
second attribute is used. The current branch (where the insertion caret is positioned)
of the outline is sorted.

There are 3 options for the scope of the sort.
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e The sort is only performed on the level of the current item
e Besides the current level, all levels below on the current branch are sorted.
e Sort the entire outline.

When the current item is on the first level, and the second option is selected, the
entire outline is sorted.

The Sort Branch command is located on the Outline menu.

Sort X]
First Sort Then Sort [ o |
T | |custon v|
[ ] Descending [ ] Descending

Scope of Sart

(%) Sort cument level only
(3 Sart curent level and belaw

(3 Sart entire autline

3.17.7 Search the QOutlines

© 1999-2006 Natara Software, Inc.



Bonsai Outliner for Windows 79

3.17.7.1 Find Command

The desktop application Find command is located on the Edit menu. The command
searches the current outline for the text. The search starts from the current cursor
location and continues to the end of the outline. A prompt is displayed to continue
the search from the top of the outline.

The search is performed on both the outline title and the notes. Collapsed branches
will be searched. Items that are not displayed because of a filter are not searched.

Find E |
Find project
[ tatch casze

The found text is selected to highlight it. Use the Find Again command to locate the
next occurrence of the text.

3.17.7.2 Replace Command

The desktop application Replace command is located on the Edit menu. It is used to
find and replace text within the outline and notes.

The search for text to replace starts from the current cursor location and continues to
the end of the outline. A prompt is displayed to continue the search from the top of
the outline.

The search for text to replace is performed on both the outline title and the notes.
Collapsed branches will be searched. Items that are not displayed because of a filter
are not searched.

Replace E|
Findwhat: |4pples
Fieplace With: | Oranges
Feplace Al
[ Match caze
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3.17.7.3 Google Desktop Integration

The Bonsai Windows application includes indexing and search plug-ins for Google
Desktop. The plug-ins are installed during the Bonsai setup. The indexing plug-in will
appear on the Google Desktop Preferences screen.

Once the Google Desktop has indexed the Bonsai outlines searches for text within
the outlines can be performed.

Bonsai results will be displayed with a Bonsai outline icon for search results.
Selecting that result will launch Bonsai and display the outline and item for the
indexed content.

£ features - Google Desktop - Mozilla Firefox
Fle Edt Vew Go Bookmarks Took Help

@ - K - [%1 VI.’\ @n> O oo [GL
Homea:

Back Redoad
i3] Google Mews ¥ Matara Projects Page () Matara Software | | Natara Mirror 2
@ Hatara User Forums ) features - Google Desktop =

Projects\BonsaDeskTopParts'\Bonsa...\BonsaiCrawler_p.c

¥

0 Breatures

Features
gwayland\Bonsai To Fix ot fuid=242434280 - Oy

[ BonsaiGdiAction p.c
endd #if ITARGET IS _NT40 OR_LATER) efror You nead a Windows NT 4.0 or Iater
to run this stub bacause it uses these features: emor -Oif or -Owcf, more ™

The Bonsai setup must be run again to install the plug-ins if the Google Desktop is
installed after Bonsai.

j Note: The Bonsai search plug-in is not used by the Deskbar for
searches.
3.17.7.3.1 Google Desktop Setup

For the Bonsai indexing plug-in to work it must be enabled on the Google Desktop
Preferences screen. Indexing of Text and Other Files must also be enabled.

If the outline files that should be indexed are stored on a network share then the
share must be added to the list of shares for Google Desktop to index.
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2 Google Desktop Preferences - Mozilla Firefox
Fle Edt Vew Go Bookmarks JGLEE Help

@« .5 . g w @ ntpsifaiz ¥ | O e |[GLI
Back Reload Home
15| Google Mews ¥P Matara Prajects Page i Natara Software || Matara Mimor 2
@ Natara User Forums ) Google Desktop Preferences ¢ |
"
Cl O ‘ﬂg[e Preferences - Indexing - Display - Other Praferences Help
Desktop
Preferences (changes apply to Google Desktop application)
Indexing
Search Index the following items so that you can search for them
Types
[ Email O ward O] calendar
O Chats O Excel O Tasks
] web history [ PowerPaint ] Motes
[ Media files [ rOF O Journal

Text and other files [ Contacts

Password-protected Office documents (Word, Excel)
Secure pages (HTTPS) in web history

Plug-ins Index these additional items

[#] Matara Bonsai outline indexing plugin (Indexes Bonsai .otl outline files)

K

3.17.8 Backup My Outlines

Bonsai stores outlines on your desktop computer in files with the extension OTL.
With Bonsai you are able to create these files in any directory. When you create a
new outline on your handheld and synchronize the Bonsai conduit creates the
desktop outline in the directory specified in the Settings dialog.

Your desktop backup procedure should include all of your OTL files.

3.17.9 Export an Outline

There are several export formats supported by the desktop application. Several
predefined formats cannot be customized. Bonsai also supports customer defined
formats. Both types are discussed in the following sections.

The export commands are found on the Export menu off the File menu. The fixed
export formats are listed above the Options menu command. The customer defined
formats are shown below the Options menu command.
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3.17.9.1 Fixed Format

The formats include; comma separated (CSV), text, HTML, and XML.

A dialog is available to setting options on what is included in the text and HTML
export files. The dialog is displayed by the Options command on the same menu.

E
Export Type Description
Format Description
XML Creates an XML file that contains all the outline information. A data
type definition (DTD) file is available in the Bonsai installation
directory.
CSv Creates a comma-delimited file suitable for importing into databases
or Microsoft Excel.
HTML Create a web page.
Text Creates a flat text file.

The order of the columns for the CSV export is as follows;

Title
Unique Id

Priority

Create date
Start date

Due date

10. Competed date
11. Category text
12. Keywords

13. Contact

14. Note

©CoNoUh~WNE

3.17.9.2 Customer Defined Export

Item type ( 0=Simple, 1=To Do, 2=Task)
Outline depth (O=root)
Percent complete

By creating an export template file, you can customize the exporting of a Bonsai
Outline. Here is a simple example that creates a text file that includes the title,
indents each level by four spaces, and only numbers leaf items.

[ HEADER]

Title: #TITLE#

[ BRANCH_BEG

N]
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#LEVEL(" ") #TEXT#
[ LEAF_BEG N|
#LEVEL(" ") #NUVBERY #TEXT#

The exported file would look something like the following.

Title: My Qutline

Weekend Chores
1. Cdean gutters
2. Cut grass

Fun t hi ngs
1. Go to novies
2. Go swi nm ng
3. Take a ride

An Export Template file is a text file that has the extension "OXT". All template files
stored in the Bonsai installation directory will be shown on the Export menu below
the fixed export formats. Several example template files are included and installed

by Bonsai.
T e e Iz pGI.I'CIILID LWL
i children items.
Synchronize _ .
T + 2.B.1 This child
Select User...
Import...
Export CSV File...
=4 Print... Chrl+p Text File...
L HTML...
Template Print 3 =
ﬁ Print Previ XML...
; rint Preview
- Copy of text example
% Page Setup
CustomerHTML example
1 Qutline Hierarchy.OTL e

An Export Template file is made up of sections that describe what will be written to
the export file. Each section begins with a line containing the section name in the
first column. The section continues until another section name is seen, or the end of
the file is reached.

Use a text editor, such as notepad, to edit the template file. Make a copy of one of
the example template files, or start a new file with the extension "OXT". All section
and substitution names are case sensitive. Text before the first section name is
ignored allowing comments regarding the template to be placed at the start of the
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file.

Each section contains text that is passed through unchanged to the export file and
substitution names that are replaced with values from the outline. Not all
substitutions can be used in all sections. If you use a substitution for an item
attribute (e.g., #NOTE#) in the Header section, an empty string will be inserted. The
following table defines the sections.

Section Name Section Description

Section

Description

[OPTIONS]

This is a unique section in that it does not contain text to be
written to the output file, but instead contains options that control
aspects of the export. The table on the following page defines
the contents of the Options section.

[HEADER] Written at the start of the export file.

[FOOTER] The last section written to the export file.

[ITEM_BEGIN] Written once for each item in the outline.

[ITEM_END] Written once for each item in the outline after the completion of

the branch (all children of the item have been processed).

[BRANCH_BEGIN]

Written once for each item that has child items. When this
section is used, the [ITEM_BEGIN] section is skipped.

[BRANCH_END]

Written once for each item that has child items after all the child
items have been processed. When this section is used, the
[ITEM_END] section is skipped.

[LEAF_BEGIN]

Written once for each item that does not have child items. When
this section is used, the [ITEM_BEGIN] section is skipped.

[LEAF_END] Written once for each item that does not have child items.
When this section is used, the [ITEM_END] section is skipped.
[NOTE] Written once for each item that has a note. Immediately follows

either; [[ITEM_BEGIN], [BRANCH_BEGIN], or [LEAF_BEGIN]

[FOOTNOTE_BEGIN]

Written once after all items in the outline have been processed

[FOOTNOTE]

Written once for each item that has a note.

[FOOTNOTE_END]

Written once after all the [FOOTNOTE] sections have been
written.

The Options section is used to specify control options for the export. Options are
entered one to a line in an "Option=Value" format. Blank lines and spaces are
ignored. Here is an example that would be used in a template to generate a web

page.

[ OPTI ONS]
EXTENSI ON=HTM
MARKUP=1

Tenpl ate sections

The following table lists all the supported options.
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Option

Description

Option Name

Description

OUTPUT

The name of the output file. When this option is not defined in the
template, Bonsai will prompt for the output file name using the name of
the outline file as the base name.

Example: "OUTPUT=c:\report.html"

EXTENSION

The default file extension for the export file. This extension is used in
the export file save dialog. If this option is not given, the default is
"TXT". Example: "EXTENSION=XML"

MARKUP

If the markup option is "HTML" or "XML", characters used for markup
languages are converted to special character sequences. These
changes are made in outline text, notes, categories, and the outline
titte. The template text is not modified. These sequences are
translated for both "HTML" and "XML". '>'="&gt;" '<' = "&It;" '&' =

"&amp;" " = "&quot;" The apostrophe sequence is only translated for
"XML". " ="&apos;"

Example: "MARKUP=HTML". The default value is "NONE".

TAG_URLS

If the markup option is "HTML", text in the outline item title and notes
that are recoginized as URL's are converted to anchor tags of the form
"<a href='URL">'URL"</a>".

If this option is set to 0 the anchor tag insertion is not done.

MAX_LEVEL

This option limits the levels of the outline that are exported. The default
value of O will export the entire outline. A value of 1 will export only the
outermost level of the outline. Example: "MAX_LEVEL=2"

NO_DATE

This string is used when a replacement is made for a date that is not
assigned. For example, it a To Do does not have a due date and the
#DUE_DATE# replacement is used; the value of this option will be
inserted.

NO_CATEGORY

This string is used when a replacement is made for the Unfiled
category.

NOTE_NEWLINE

Defines a string to substitute for newline characters within notes.
Example: "NOTE_NEWLINE=<br>"

NOTE_NEWLINE_CHAR

Defines a single ascii character to substitute for newline characters
within notes. The ascii character value is given in decimal.
Example: "NOTE_NEWLINE_CHAR=127"

PRIORITY

Defines a text substitutions for the priority numbers (1..5). Provide a list
of 5 comma separated names.

Example: "PRIORITY=highest,high,medium,low,lowest"

The following substitutions have a single value during the export.
Substitution Description
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Substitution Name Description

#TITLE# The name of the outline file. Does not include the extension.

#NUMBERING# The type of numbering is used on the outline. 0 — none, 1 — basic.
As Bonsai supports more numbering formats, this list will expand.

#CATEGORIES# The categories as a comma separated list.

#COLLAPSED_ITEMS# |The Id's of all the collapsed items as a comma separated list.

#TODAY# Today's date

#NOW# The current time and date

#FILE_NAME# The file name of the outline being exported.

#FILTER_NAME# The name of the active filter used for the export.

As the outline is exported, the following substitutions are given values from each item

in the outline.
Substitution Description
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Substitution Name Description

#POSITION# The location of the item in the outline. The first item is at position
0.

#ID# A unigue number assigned to each item in the outline.

#PARENT# The unique Id assigned to the parent of this item (O for level O
items).

#LEVEL# The indentation level of the item. Items not indented are at level
0.

#LEVEL1# Same as #LEVEL#, but 1 based.

#LEVEL (" XXX")#

Repeat the quoted string "XXX" by the level number for the item.
For example, if you put a tab between the quotes, you can tab
indent an item by the depth of the outline. Items at the outer level
insert an empty string.

#TYPE# The item type. 0 — Simple, 1 — To Do, 2 — Task

#NUMBER# The outline numbering for the item.

#FULLNUMBER# The outline numbering where all levels are included (e.g., "2.3.1")
#PERCENT# The percent complete for an item. If the item is a Simple type, the

string is empty.

#STATUS('N","Y")#

If the item is not completed, insert the first quoted string. If the
item is completed, insert the second quoted string. If the itemis a
Simple type, an empty string is inserted.

#TODO_STATUS("N","Y")#

If the item has the type To Do, then the text from the quoted
strings are replaced as done with STATUS. Otherwise, an empty
string is inserted.

#TASK("string")#

If the item has the type of Task, then the quoted text is inserted.
Otherwise, an empty string is inserted.

#SIMPLE(" string" )#

If the item has the type of Simple, then the quoted text is inserted.

#CREATE_DATE#

The date the item was created.

#START_DATE#

The start date. If the item is a Simple type, an empty string is
inserted.

#DUE_DATE#

The due date. If the item is a Simple type, an empty string is
inserted.

#COMPLETED_DATE#

The completed date. If the item is a Simple type, an empty string
is inserted.

#CREATE_DATEN#

The date the item was created as the number of seconds since
Jan. 1, 1970.

#START_DATEN#

The start date created as the number of seconds since Jan. 1,
1970. If the item is a Simple type, an empty string is inserted.

#DUE_DATEN#

The due date as the number of seconds since Jan. 1, 1970. If the
item is a Simple type, an empty string is inserted.

#COMPLETED_DATEN#

The completed date as the number of seconds since Jan. 1, 1970.
If the item is a Simple type, an empty string is inserted.

#ELAPSED_DURATION#

The number of days between the start date and the end date
inclusive. If the item is a Simple type, an empty string is inserted.

#PRIORITY#

The priority. A value of 0 is used for a priority value of none.

#PRIORITY_NAME#

The priority text for the priority of the item. See the PRIORITY
parameter in the option section. An empty string is used for a
priority value of none.

#CATEGORY#

The category name.
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3.17.9.3

3.17.9.4

Command Line Template Export

The Bonsai Windows application can perform a command line export of an outline
using a customer defined template file. This can be useful if you have an outline that
is regularly exported to an intranet after synchronization. The syntax of the export
command is:

BONSAI / EXPORT <outline file nane> <tenplate file nane> <output file> |
[filter:<filternane> ]

The filter option is optional. The filter name is case sensitive and there are no
spaces between the option and the name of the filter.

The values returned by Bonsai for the export command are as follows.

¢ 0 - The import was completed without error.

¢ 1 - Not able to read the outline file. The file name may be invalid.

e 2 - Not able to read the template file. The file name may be invalid.
¢ 3 - Not able to write the output file. The file name may be invalid.

The user interface is not displayed when this command line option is used.

j Note:

Use the full path and extension to the file names on the command line.
Use quotes around file names that include spaces.

Command Line XML Export

The Bonsai Windows application can perform a command line export of an outline to
XML. The syntax of the export command is:

BONSAI / XMLEXPORT <outline file nane> <output file>

The entire outline is always exported. All of the outline's attributes, including filters,
display columns, expand - collapse state are included in the XML output. The
definition of the format is described in the file "bonsai.dtd" that is installed in the
Bonsai application installation directory.

The values returned by Bonsai for the export command are as follows.

e 0 - The import was completed without error.
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¢ 1 - Not able to read the outline file. The file name may be invalid.
¢ 3 - Not able to write the output file. The file name may be invalid.

The user interface is not displayed when this command line option is used.

23

Note:

Use the full path and extension to the file names on the command line.

Use quotes around file names that include spaces.

3.17.10 Import Data
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3.17.10.1 From a Text File

The desktop application supports importing from a text file. Each line in the file is
used to create an item in the outline. Tabs at the start of each line are used for the
outline levels.

The import command is located on the File menu. The command creates a new
outline with the imported information. After performing the import, the save
command will create a new Bonsai outline file.

3.17.10.2 From a Comma-Delimited File

The desktop application supports importing an outline from a comma-delimited file
(file extension 'CSV'). Each line in the file is used to create an item in the outline.
There are 2 formats that can be used.

1. The fields in the CSV should follow the same order as the standard Bonsai

CSV export.
2. The first line of the CSV provides the column names that are present in the
CSV file.

Requirements for the CSV include the following.
e A comma must separate each field.
e Text fields must be in double quotes
e The unique Id field can be 0, in which case Bonsai will assign a value.

Example line for fixed format:

" A
test","o","1","0","0","3","4/16/01", "4/ 16/ 01", "4/ 17/ 01", "4/ 17/ 01", " Busi ness", " @Hone", "Sm th", "
A note"

Example when providing a line that specifies the columns present in the CSV file:

"text","notes","category"
"Atest","Some Notes","Business"
"Second iten,"Notes on the subject","Personal"

The Import command is located on the File menu. The command creates a new
outline with the imported information. After performing the import, the save
command will create a new Bonsai outline file.

Bonsai will also import a CSV file when it is dropped on the application window.
The column names used in CSV files are as follows.

"unique-id" or "id"
"create-date" or "created"
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"start-date" or "start"
"due-date” or "due"
"completed-date" or "completed”
"level"

"precent-complete” or "precent”
"priority"

"type"

"custom"

"contact”

"keywords"

"text"

"notes”

"category"

3.17.10.3From an XML File

The Bonsai Windows application can perform a command line import of an XML file.
This can be useful if you have an external source of data that you want to automate
the import and synchronization with your handheld. Bonsai supports several outlines
that use XML;

e The Bonsai XML export format.

¢ Outline Processor Markup Language - OPML
e Mind Map

e Mind Manager

e Shadow Plan

The syntax of the import command is:

BONSAI /1 MPORT <inport file nane> <outline file name> [ /sync:(0|1) ] [
/user: <Hot Sync User Name> ] [ /category: <category> ]

The sync and user parameters are optional. By default, the created outline will be
configured to synchronize with Bonsai's current HotSync User.

Use the user parameter if you have more than one HotSync User on your desktop
and need to direct the outline configuration to a specific user. Use quotes around
user names that include spaces.

Include the parameter "/sync:0" to disable synchronization for the outline.

The values returned by Bonsai for the import command are as follows.

e 0 - The import was completed without error.
¢ 1 - Not able to write the outline file. The file name may be invalid.
e 4 - Not able to read the XML file. The file name may be invalid.
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¢ 5 - Not able to update the shortcut file.
¢ 6 - The HotSync User name is not valid.

The user interface is not displayed when this command line option is used.

j Note:

Use the full path and extension to the file names on the command line.
Use quotes around file names that include spaces.

3.17.10.4 From Other Palm OS Outliners

The Bonsai Windows application can import from several other Palm OS outliners.
Use the File Import command or simply drag and drop the backup of the Palm
outliner database (extension ".PDB") onto the Bonsai application.

Supported formats;
e ThoughtManager
e BrainForest

3.17.10.5Command Line Import

The Bonsai Windows application can perform a command line import from a CSV
file. This can be useful if you have an external source of data that you want to
automate the import and synchronization with your handheld. The layout of the CSV
file is the same as that produced by the CSV export command.

The syntax of the import command is:

BONSAI /1 MPORT <inport file nane> <outline file name> [ /sync:(0|1) ] [
/user: <Hot Sync User Name> ] [ /category: <category> ]

The sync and user parameters are optional. By default, the created outline will be
configured to synchronize with Bonsai's current HotSync User.

Use the user parameter if you have more than one HotSync User on your desktop
and need to direct the outline configuration to a specific user. Use quotes around
user names that include spaces.

Include the parameter "/sync:0" to disable synchronization for the outline.

The values returned by Bonsai for the import command are as follows.

¢ 0 - The import was completed without error.
¢ 1 - Not able to write the outline file. The file name may be invalid.
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¢ 4 - Not able to read the CSV file. The file name may be invalid.
¢ 5 - Not able to update the shortcut file.
¢ 6 - The HotSync User name is not valid.

The user interface is not displayed when this command line option is used.

23

Note:

Use the full path and extension to the file names on the command line.
Use quotes around file names that include spaces.

3.17.11 Link to External Resources

The Bonsai desktop application supports several external resource links, such as
URL's. The links can appear in both the outline item's title and notes.

5 + M 1.4 Master bedroom
6 |¥ 2. master/bathrooms

7 + O 21 baseboards
8
9

b + 122 |Shy|ight's http://www.bristolite.com/
w 3, Den

e Y ¥ |

Pella also has nice shylights hllp:f{mmm.pellm.eom

The hand cursor is displayed when the mouse is positioned over a link. Left clicking
on a link will pass the link to the Windows to open. The color used for links can be
configured in the Settings dialog.

Bonsai recognizes the following types of external resources.

e http://

e https://

o ftp://

e mailto:

o file:/l/ Drive letter based file path. "file:///C:\temp.txt".

o file:\\ UNC based file path. For example
"file:\\ComputerName\ShareName\temp.txt".
e outlook:
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The Insert File Link command on the Edit menu can be used to insert a properly
formatted file link.

Spaces are not allowed within the links. Use '%20' to represent spaces. For

example; "file:///C:\Program%20Files\memao.txt". The Insert File Link command will
automatically translate the spaces.

ZNote: Bonsai will pass the full external resource link to Windows. What
Windows does with the link will depend on how you have Windows
configured. Bonsai does not attempt to determine what application
will handle the external resource link.

3.17.12 Jump Back from a Link

The Windows desktop application does not have a corresponding application to the
Back-2-Bonsai handheld applications. However, it does have some support through
the command line and keyboard shortcuts.

Bonsai has a keyboard shortcut, Alt+J, that will take a link tag number from the
Windows clipboard and open the outline and position the cursor to the linked item.

To use this feature, highlight a Bonsai link tag in the Palm Desktop or Microsoft

Outlook and copy it to the Windows clipboard (usually Ctrl+C). Switch to the Bonsai
application and enter Alt+J.

What has happened today. {BZ1} - Task
File Edit View Insert Format Tools
[& save and Close B I  +3Recur

Task ] Details ]

Subject: “."u'hat has happened today. {EZ1}

E Duedate:  |Fri2/10/2006 | |"?

If you can not copy the link tag number to the clipboard, use Alt+Shift+J to display
the Jump to Link dialog. The dialog accepts the link tag number.
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Jump to Link

Link. tag number: |7

The command line option "/linktag:#" is available to perform the same action as the
keyboard shortcut described above. The command line option can be used from
scripting languages to automate the jump to link. An example that works with
Microsoft Outlook is provided with the Bonsai installation. The following command
line would display the outline that referenced link tag number 9.

BONSAI /Iinktag: 9

If the Bonsai application was already running, the request is passed to the Bonsai
application and it will display the outline.

23

Note: Each HotSync User has their own set of Link Tag numbers. The
corresponding HotSync User must already be selected in the Bonsai
Windows application.

3.17.12.1 MS Outlook Example

An example macro is included with the Bonsai installation that demonstrates the
ability to launch Bonsai and display a linked item. By placing a button linked to this
macro on the Outlook toolbar, and the forms for task and event details, you can
quickly jump to the Bonsai outline with the linked item.

Here are the steps to install this example.

Install the macro

e Hit Alt+F11 from within MS Outlook to open a MS Visual Basic window.

¢ Right click on the Project icon in the Project Explorer window and select Import
File from the context menu.

e Navigate to the Bonsai installation directory and select "Back2Bonsai.bas".

e If Bonsai was not installed in the default folder under Program Files, then edit the
Launch Bonsai function in the module and change the path to the actual
installation folder.

e Save the project (click save icon) and close the Visual Basic editor.

Create a toolbar button

¢ Right-click on the MS Outlook toolbar and select Customize from context menu

to display the Customize dialog.
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e Select 'Macros' in the Categories list.

¢ Click and drag the 'DoBonsai' macro from the commands list to the MS Outlook
toolbar.

¢ Before closing the Customize dialog, right-click on the 'DoBonsai’ button on the
MS Outlook toolbar to display the context menu.

¢ Find the Name entry on the menu and change the button name to Back2Bonsai.

¢ Optionally, the icon can be changed using the same context menu.

¢ Close the Customize dialog.

The Back2Bonsai button is now configured and ready for use.

+ 2] B o & W [M =iBack2Bonsai .

Lok, fiour v Search In~ Task
01 ¥ Subject

| baseboard[B23]
kbR
| Windows[BE4]

Place your cursor on a To Do that contains a Bonsai link tag and click the
Back2Bonsai button.

Repeat the procedure used to create the toolbar button on other forms, for example
Task Details, where you want to jump to Bonsai.

%
&

Note: MS Outlook 2003 has additional security on the body of a task or
event that will cause a security pop up to be displayed. See the
script source code for information on the Redemption Library and
other ways to work around this message. Otherwise, you can
respond Yes to the security dialog.

Note: If you get an error "Macro language support is disabled”, you may
have the Visual Basic for Application shared features disabled.
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3.17.12.2 Palm Desktop Example

An example Palm Desktop add-in is included with the Bonsai installation that
demonstrates the ability to launch Bonsai and display a linked item. This add-in is
automatically registered with the Palm Desktop when Bonsai is installed.

When you run the Palm Desktop you should see the Back-2-Bonsai icon on the
toolbar.

E% palm Desktop
Fle Edit View Tools HotSync Help

EH & #h oS- (ﬂ} User: IE

L S
Goto... | | Today | 1 Wednesday
5/19/2004 1
4 T W Th F = g
1 2
t i 4 5 & T 5 3
10 1 12 13 14 15 16
- - 7 o [l o 2 e e
My test event [BZ3]

[1hr)

Click on a To Do or Event that contains a Bonsai link tag within the Palm Desktop
application. Then click the Back-2-Bonsai button. The Bonsai application will be
launched and the cursor positioned on the linked item.

3.17.13 Reuse an Outline

Bonsai has a command to clear the status for all items in an outline. The Reset

command is located on the Outline menu. The operations performed on the outline
are:

e Clear all To Do check boxes
e Set percentage complete of all tasks to 0%.
e Set all dates (start, due, completed) to the 'no date' value

© 1999-2006 Natara Software, Inc.



98 Natara Bonsai User Manual

3.17.14 Filter for Overdue Items

To create a filter that will display overdue items, set the Status to "Incomplete” and
set the Due Date to "Due Within 0 days". You can vary the day to include items that

will be due soon.

Define Filter

General | Options | Dates | Categories | Keywords |

MName: |O'~rerdue ftems

Status: |Incumple‘te Vl
Type: |AII Types Vl
Priorty: | All Priorties v|

Link: | Link Fiter (OF) v

Texd: ||

[ ] Also search notes

oK || cancel
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Define Filter

General || Options |m| Categories || Keywords
Start date: |,p.,|| Dates w |
Due date: | Due Within v| | ﬂ'| dayis)
Completed Date: |.Pd| Dates w |
Contact: | w
[ ] Match any contact name
oK || cancel

4 Bonsai Outliner for Palm OS

This topic describes the Bonsai outliner application for the Palm OS.

4.1 Launching Bonsai

Once Bonsai is installed on the Palm OS handheld an icon will be displayed on the
Application screen. Tap on the Bonsai icon to start Bonsai. Bonsai will return to the
outline that you were last working on.
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4.2

=
&

Quick Tour Bonsai Calc

g

Expense  Favorites Files

Main View

This is the outline view with a number of attributes shown. Since this leaves little
room for the outline text, usually only a few of the attributes are shown. Configuring
what is shown is done through the column header and the Preferences dialog.
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Qutline title w filter Off et Filter Selection
Column Header
Expand-collapse - @- 1. Kitchen ﬁ-f 1/10
Priority & a.lnstall cabinets - 1/B
Grab handle ¢ [1E b. Install counters 1/7
< @E’ c. Install sink 1/1(t=——— Date column
¢ (1] d.Paint ~# 17
v @ O Z. Finish trim @ =slffeet  Link column
¢ [1|& a.First staincoat - -
<& @E’ b. Second stain —sss—— Oufline text
coat
Task progress bar —f—o-4-/m ¢, First varnish o -
¢ @D d. mand .. [ —st———t— Note column
Toobar s BEaRERN «

Edit the outline text directly in this view.

The grab handles are used for drag and drop operations.

Edit the notes by tapping on the note icon.
Quickly change a date by tapping on the date column.

The tools that are displayed on the toolbar can be configured in the Settings dialog.

Tap the H icon to switch tool sets.
Tap on the filter selection to filter the outline or to edit the filters.

Tap on the link column to create a new link, or jump to where a link points.

421 Views

The Bonsai application on the handheld uses Views to manage what attributes of the
outlines are shown. When a new outline is created a default view is created. You can
add additional views using the Views dialog. You can then configure the views to
show different attributes of the outline. Bonsai remembers the columns and widths
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for each view.

Outline Hierarchy [iaiiscnsii

¢ 1. Thisiterm has no children
¥ 2. Thisis a parent
¥ 2.4 Thisis achild and parent item.
¢ 2.48.1 Thisis a child
L @ 2A2 Asecond child item
¥ 2.B This parent is collapsed and
hides the children items.
¢ 2.B.1 This child was hidden

T

The columns available for display include;
e Text
¢ Note icon
e Link icon
e Start date
e Due date
e Completed date
e Days until due
e Category
e Category icon
e Contact
e Contact icon
e Keywords
e Keyword icons
e Custom

There are 4 ways of switching the current view;
e The View command on the View menu.
e Select View from the menu displayed when tapping on the column header.
e Use the Views toolbar button (configured in the Settings dialog).
¢ When switching between portrait and landscape modes on handhelds that
support both orientations.

Tap on the outline header to display a menu of options. When adding columns to the

© 1999-2006 Natara Software, Inc.



Bonsai Outliner for Palm OS 103

header, the column will be inserted to the left or right of the column that was tapped
depending on which side of the column was tapped.

Homein lllinois w Filter Off

Text ~lal M
¥ o . \Windows an|Hide Header
¢ & 1.4 Family ro|Sort Ascending
¢ o 1.B Dining rod Sort Descending
¢ O 1.CKitchens |Hide Column
¢ O 1.0 Master b|Show Column...

¥ B0 2, master bat RIS
¢ & 2.Abaseboardss e 5/
¢ [] 2.B Broken tile a0 4730
6 O 2.C Skylight A 4/30
¥ mm 3, Den = B/

LR EENRERDY

Commands available on the header menu include;

Command Description

Hide Header Collapsed the outline header to a narrow line. This increases the
space available to display the outline.

Sort Ascending Displays the Sort dialog with the current column selected and
ascending as the sort option.

Sort Descending Displays the Sort dialog with the current column selected and
descending as the sort option.

Hide Column Hides the column that was tapped. No action is taken on the
text column.

Show Column... Displays a menu of columns that can be displayed.

View... Displays the View dialog where Views can be added, deleted, of
selected.

4.3 Zoom in on a Branch

Bonsai has the ability to zoom in on a branch. Since there is less room on the
handheld screen than the desktop, it may be necessary to zoom in on a branch to
view or edit the text.

When zoomed on a branch the title of the outline is replaced by the name of the

© 1999-2006 Natara Software, Inc.



104 Natara Bonsai User Manual

branch.

Remcdenng w [ilter Off

¥ (1 |mm 1, Kitchen 24 1/10
¢ 1™ a.lnstall cabinets - 1/6
¢ (1) b. Install counters 1/7
¢ 1 c.Install sink 1/10
¢ 1]& d. Paint i 1)T

¥(1]Q 2. Finish trim & -
¢ [1|& a.First staincoat - -
¢ 1/ b. Secondstain - -

coat
@ @-ZI C. First warnish e -
¢ (1)O d.sand @ -

- = - — .
LR EETIRAERDY -
w Filter OFf

¢ 1 a]nstallcabinets - 1/6
¢ (1]& b.Install counters 1/7
¢ [1F c.Install sink 1/10
¢ (1 d.Paint /7

NN Bk S Pl

Before Zoom After Zoom

The Zoom Out command returns to the original view.
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4.4  Grouping Outlines

Use the category capability of Bonsai to group related outlines. You can filter your
outlines by category on the outline list view. If one of the hard application buttons is
assigned to Bonsai, pushing the button will cycle through the categories on this view.

Natara Bonsai [l All

Name guSir;’ess_
Doy o ects
Item Types
Outline Hierarchy Travel Notes
test Unfiled
Edit Cutegories...

[Open ] [ New ] [Detuils] [ Delete]

4.5 Item Details

Besides its title, each item has an additional set of attributes. When not displayed on
the outline view, these attributes can be viewed and set on the details dialog. The
following topics describe the information on each tab.

45.1 General Tab

The General tab contains the item type, category, and priority and completion status.
The information shown on the General tab is dependent on the item's type. Simple
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items do not have a completion status.

Thisis a parent o

General|Dates|Links|Text|Note

Type: BELHEN ToDo | Task
[0 Parent of Next Action ltems

Priority: [None |1 |2 415
Category: ¥ Personal
Cost: 12

| QK ||Cunce||

Thisis aparent
GeneruI]Dutes]LinksIText]Nnte]

Type: |Simple Ian Task

[0 Parent of Next Action Items
O Completed

Priority: | None | 1 24 5
Category: ¥ Personal

o

| QoK || Cancel |
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Thisis aparent o

General|Dates|Links| Text|Note

Type: |Simple|ToDo
[0 Parent of Next Action I[tems

0 %% Complete

Priority: | None | 1 24 5

Category: ¥ Personal
Cost:

| QK ||Cunce||

4511 Type

Each item in an outline is one of 3 types: simple, to do, and task. The type assigned
to an item when it is added to the outline is controlled by a preference. The type can
then be changed from the details view.

A Simple item can be changed to either a To Do or a Task by tapping (or right click)
on the status icon and selecting the type from the pop up menu. With the desktop
application, right click on the completion status to display the item type menu.
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451.2

‘Item Types v Filter Off

¢ - 1.Thisis asimple item and does
not have a completion status.

¢ O 2. This ToDois not done.

¢ [ 3.This To Dois completed.

¢ 34, This task is not started.

< E35. This task is 50% done.

¢ mm6. This task is completed]

T e

Status

Items of type To Do and Task have a completion status. To do's are either done, or
not done. Tasks have a completion status between 0% and 100%. The status can
be set directly on the details dialog. The hard scroll buttons will change the percent
complete of a task by 10% for each press.

The status of an item can also be set from the outline view when the completion
status is shown (a preference setting). Tap (or left click) on the progress bar and
drag left and right to change the percent complete.

On both the desktop and Palm device, command and shortcuts are provided that
toggle the completion status
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Remodeling SRl | Remodeling w Filter OFf

=,

¥ | Kitchen
¢ & a.lnstall cabinets
¢ & b.Install counters
¢ o clnstall sink
¢ & d.Paint

¥ O 2 Finish trim
¢ ™ _a.First stain coat
< econd stain coat
¢ /. First warnish
¢ O dsand
¢ O e. secondwarnish

T ey

¥ mm | Kitchen
¢ & a.Install cabinets
¢ & b.Install counters
¢ O clnctall sink
¢ & d.Paint

¥ O 2. Finish trim
¢ ™ _a.First stain coat
< econd stain coat
< ® ¢, First warnish
¢ O d sSand
¢ O e. Secondwarnish

LR EEARERY

Remodeling

w Filter OFf

¥ | Kitchen

¢ M a.lncstall cabinets
¢ M b.Install counters
¢ & cInstall sink

¢ o d.Paint

¥ O Z.Finish trim
¢ & a.First stain coat
¢ & b. Second stain coat
< B¢, First warnish

¢ O d.Sand

¢ O e.Secondwarnish

T =ty

When you change the completion status of an item, the completion status of its
parent items is recalculated. A preference setting is available to disable this

behavior.

Priority

Each item has a priority from 1 to 5, or no assigned priority. Priority 1 is considered
the most important. You can filter the outline with a priority. The priority of an item
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4514

can be set from the outline view when the priority is shown (a preference setting).

‘Outline Hierarchy IIAAiLAS

© (1) 1. This item has no children
w (3)2. This is a parent
¥ (1)2.A This is a child and parent
item.
¢ (D a. This is a child
¢ (1)b. A second child item
w|None |his parent is collapsed and
1 des the children items.
‘his child was hidden

2
3
4
5

L= R ERSY

The priority assigned to new items can be set in the preferences.

Category

Categories provide a customizable attribute that can be used as desired. Each item
in the outline can be assigned to a category, or left unfiled.

The outline can be filtered on category. For example, you could use the categories
with a To Do list to indicate the best time of day to perform the work. You could then
filter your To Do list on time of day.
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Edit Categories o

After work
Anytime
During Lunch

Morning

[ 0K ] [ MNew ] [ Rename ] [ Delete ]

Define Filter i
Ge...|Op...|Dates|Category [Keyword

Select Categories:

Unfiled

' After work
Anytime
During Lunch
Morning

v Weekend

[ OK ][ Cancel |

o

j Note:

Categories use the Palm OS category feature, and are limited to 15
user-defined categories.
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4.5.2

45.2.1

Dates Tab

The Dates tab has the dates for items with a type of To Do or Task.

| General | Dutes]Links]Text]Note]

Created: 12/7/05
Start: ¥ 12/7/05

Due date: ¥ 12/31/05
Completed: ¥ 12/28/05

| OK ||Cunce||

The dates of parent items can not be modified if the option to roll up dates is
configured.

Dates

Items of type To Do and Task also have a Start, Due and Completion date. When a
To Do is checked completed, or a Task is marked 100%, the completion date is set
to the current date. The completion date can also be manually set to another date.

Besides the ability to select a date from the calendar, the Palm application provides a
menu of quick dates. The entries on the menu are specific to the start, due, and
completion date uses. The pop-up menu is available from both the details dialog and
the outline view (when a column of dates is shown).

The pop up menu on the outline view is also used to switch the display to one of the
other dates.
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~ Filter Off
v B 1. Kitchen 12/12
¢ & a.Install cabinets 12/7
¢ & b.Install counters 12/8
¢ & c. Install sink 12710
¢ & d.Paint 12/12
w B2, Finish trim 12/14

¢ & a.First stain co|No Date

¢ [ b.Second stain| Today

¢ mc. First varnish | Tomorrow
¢ O d.Sand End of Week

¢ O e.Second varn|End of Month
Choose Date

OBl Y

| General | Dutes]Links]TextINnte]

Created: 12/7/05
Start: v 12/11/05

Due date: ¥ 12/12/05
Completed: v 12/12/05

| OK ||Cunce||

When you change the start or due date of an item, the start and due dates of its

parent items are recalculated. A preference setting is available to disable this

behavior.
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4.5.3

Links Tab

An item can be linked to either another Bonsai outline, an event in the date book, or
a standard To Do. Links can be set in the details dialog of an item. Tapping on the
link icon will jump to the to do, event, or outline.

An item can also be associated with a contact name. Bonsai will auto-complete this
field with names from the build-in address book. However, you can put any text in
this field.

One or more keywords can be assigned to the item. Keywords are selected from the
keyword dialog.

Install counters o

'Generul]Dates]Links]Text]Note]
Link:

MNone Calendar | Outline
Jump to:
Contact: ¢
Keywords:

&

Delete

| QK ||Cunce||

The presence of a link is show with an icon on the right hand side of the screen. A
preference setting controls display of the icon. Tapping on the link icon will pop a

menu to either jump to the linked item, or unlink the item. Tapping on an unlinked

item, represented by the hollow diamond, will present a linking menu.

The link icons are as follows;
The item is not linked.

Item is linked to a To Do.

t% Item is linked to an event in the date book.
e o Item is linked to a Bonsai outline.
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'Remodeling v Filter Off

Text |

w1, Kitchen
¢ & a.Install cabinets
¢ & b.Installfounters
¢ & c.Install sink
¢ & d.Paint
¥ B2, Finish trim
¢ & a.First stain coat
¢ [ b.Second stain coat
<¢ Ec. First varnish
¢ O d.Sand

s E-aRERA ¢

EOED - by =

" .
" .

45.3.1 To Do Links

Setting a to do link can be done from the details dialog.

When an item is linked a new To Do is created in the built-in To Do database using
the attributes of the item (Name, Note, Priority, Due Date, Completion Status,
Category).

If there is a category in the standard To Do database that matches the category of
the item in the outline, the linked to do will assigned that category. Otherwise, the to
do will be assigned the unfiled category.

Tapping on the To Do link icon will jump to the To Do. The application launched is
configured in the Settings dialog. Bonsai can insert a link tag into the To Do to
indicate that the To Do is associated with a Bonsai outline. Configuring this option is
also done in the Settings dialog. When link tags are used it is possible to jump back
to the Bonsai outline from the To Do application. Instructions for installing and
configuring this option are given in the Back-2-Bonsai topics.
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Install counters o

'GeneruI]Dutes]Links]TextINnte]

Link:

m Calendar | Outline
Jump to:

Contact: ¢

Keywords:

Delete

2

| OK ||Cunce||

Unlinking the item, or changing the link type to outline, will break the link to the To
Do. The To Do is removed from the standard To Do database if the application
setting is enabled for this option.

O Note: Changes made on the desktop to an item linked with a To
Do require 2 synchronizations before they appear in the desktop PIM
application. On the first synchronization the changes are propagated to
the handheld To Do database. On the second synchronization the
changes are propagated to the desktop PIM application by the PIM
HotSync Manager conduits.

4.5.3.2 Outline Links

Linking an item to another outline is done in the details dialog. The name of the
linked outline will be displayed below the link selection. Tapping on the outline link
icon (the tree) will jump to the linked outline.
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'Generul]Dutes"Links]Text]Note]
Link:
None | ToDo | Calendar REeIVEi[[3

Jump to: & Outline Hierarchy
Contact: ¢
Keywords:

Delete

| QK ||Cunce||

IE &)

The link can be thought of as a master project to subproject link. The link points to
another outline, and not to an item. Changing the selection will break the link to the
other outline.

45.3.3 Calendar Links

Linking an item to an event in the date book is done on the Links tab. When the
Calendar pushbutton is tapped, Bonsai displays the Select Event dialog. There is an
option to create a new event if the event does not yet exist.

Bonsai displays the calendar icon and the title of the linked event. Tap on the
calendar icon to jump to the event. The application launched is configured in the
Settings dialog. Bonsai can insert a link tag into the event to indicate that the event is
associated with a Bonsai outline. Configuring this option is also done in the Settings
dialog. When link tags are used it is possible to jump back to the Bonsai outline from
the Calendar application. Instructions for installing and configuring this option are
given in the Back-2-Bonsai topics.
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'Generul]Dutes]Links]Text]Note]
Link:

None | To Do B&:([-13Ts[s[88 Outline
Jump to:& Finish trim[BZ3]
Contact: ¢ [z

Keywords:

H

| OK ||Cunce||

all
Select Event o

e  Finish trim[BZ3]

[ OK ] Cancel ] ( AddEvent.. )

When a new event is created by linking, Bonsai will attempt to match the category of
the outline item with a category in the date book. If a match is found, then the new
event is assigned to the category. Otherwise, the Unfiled category is used. This is
only relevant for handhelds that support categories in the date book.

23

Note:
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Adding a link to an event can only be done on the handheld. The event
links are visible on the desktop.

45.3.4 Keywords

454

One or more keywords can be assigned to an item. Keywords are useful when
filtering an outline. Icons can be assigned to keywords.

Install counters ﬂ
General | Dates | Links IText | Note |

Link:
None Calendar | Qutline
Jump to:
Contact: ¢
Keywords:

G

Delete

| QK ||Cunce||

You can assigned multiple keywords to an item on the desktop in one operation.
Click on the Add button to display the Select Keywords dialog. Select each keyword
to be added to the item and click OK.

By default the keywords will be appended to the item's existing keywords. By
checking the replace option, the existing keywords will be removed before added the
new keywords.

You can also assigned keywords to multiple items in an outline in one operation.
Select all the items using the selection gutter and select Keywords from the Item
menu.

Text

An alternative way of editing the item's title is the Text tab of the details dialog. This
can be useful if the text is too long for the handheld screen.

© 1999-2006 Natara Software, Inc.



120 Natara Bonsai User Manual

[Generul]Dutes]LinksITextINote'

Install cabinets

| OK ||Cunce||

4.5.5 Notes
Tap on the note button to display and edit the note. Each item can have a note up to

32K.
Install cabinets ﬂ
|Generu| | Dates | Links | Text | Notel

This is a hote for an item in the
outline. The text of the item s
displayed as the title of this dialog.

Notes are useful for holding detailed
information on an item.

[ 0K ][Cuncel] |

A note icon can be displayed on the outline view to show what items have notes.
Tap on the icon to display or edit the note.
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'Remodeling v Filter Off

w1, Kitchen
¢ & a.Install cabinets #|
¢ & b.Install counters
¢ & c. Install sink
¢ & d.Paint 7|
W B2, Finish trim
¢ & a.First stain coat
¢ & b.Second stain coat
< Ec. First varnish
¢ [J d.Sand |
¢ [ e.Second varnish

a2 RaaERd

4.6 Keywords

Bonsai maintains a single list of keywords that is shared by all outlines. When adding
keywords to items in an outline this list is displayed. Keywords are assigned to
categories for grouping.

The keyword list is global to all outlines. Keywords are inserted into outlines as text,
and not as references to the global keyword list. Changes you make to the global
keyword list are not reflected in the outlines.

Icons can be assigned to the keywords. The icons can then be displayed in the
outline instead of the keyword text.

Keywords for items are shown on the Links tab of the details dialog.
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Keywords o |

Category: = Location

@Home
@Work
Wheaton &l

. [Newj (Editj [Delete}l

When all keywords are shown (see desktop example above), the category is
appended to the keyword for display. When a category is selected, as with the
handheld example, the category is not appended to the keyword.

Keywords o

Category: = Location

Keyword o

@Y ork
Category: = Location

lcon:

j Note:

During synchronization the most recent set of keywords (desktop or
handheld) is copied over the other set. For this reason, perform
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4.7

4.7.1

keyword maintenance on one side between each synchronization.

Filter the View

Bonsai supports the ability to filter the items that are displayed. To access the dialog
to create new filters or edit existing filters; tap the filter drop list in the upper-right of
the handheld screen.

Several attributes can be filtered at one time. Only items that match all the selected
attributes will be displayed. For example, it is possible to filter for priority 1
incomplete items from the business category.

An existing filter can be enabled by selecting it from the filter drop-list.

—— Owverdue Tasks
=il Today's Tasks

all cabi|p s Filters...
all cour

all sink
1t #|

j Note: The current filter is automatically disabled if none of the items in the
outline match the filter.

Filter List

Select a filter to use, or create and edit filters from this dialog.

If you have create a set of filters in another outline that you would like to reuse, use
the Import option to copy them into this outline.

Select Use Filter to activate the selected filter.
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Filters:

Owverdue Tasks
Today's Tasks

( Edit )( New ](Delete] (Impnrt]
[Done] ( Use Filter ]

4.7.2 Filter Definition
The filter definition is divided onto several tabs.
47.2.1 General

The first tab contains the filter name and several criteria.

Define Filter i)
|Generu| IOptinns | Dates | Ca... | Ke...|

Name: Jim's Tasks

Status: ¥ Any status
Type: w All Types
Priority: w All Priorities
Link: w Link Filter {Off)

Text:
[0 Also search notes

‘( OK ][Cuncel]

The following filter attributes are on this tab.
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Filter Attribute Description

Name Assign a name to the filter to describe its action

Status Filter to do's and tasks based on the completion
status.

Type Filter on item type; Simple, To Do, and Task.

Priority A number of options to filter on priority.

Link Filter based on whether the item is linked or not.

Text A string to search for. Check the Also search notes
option to search for the string in notes.

Attribute When checked only these items are included

4.7.2.2 Options

This tab has options that affect the overall filter operation.

| General | Dptions]Dutes]Cu...]Ke...]

¥ Limit view to Next Action item
for Next Action branches

Basedon: w Due

¥ Display result as a flat list

Sortedby: ¥ Text
[0 Descending

Scope: w Apply filter to all items

[0 Reverse Filter Action

[ OK ](Cuncel]

The following filter attributes are on this tab.
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Filter Attribute

Description

Limit view to Next Action...

When the "Limit view..." option is selected Bonsai will
seleect a single child item to display for parents with
the Parent of Next Action Items attribute. The order
used for ranking the children can be selected here.

Display results as a flat list

When this option is checked the results of the filter
are displayed as a flat list.

Scope

By default the filter is applied to all items in the
outline. There are two options for limiting the filters
use.

Reverse Filter Action

When this option is checked Bonsai will reverse the

results of checking the filter against a single item.

Attribute

4.7.2.3 Dates

When checked only these items are included

This tab contains date and contact filtering options.

o

Define Filter

Start Date:
w Startby

Due Date:
w Today

Completed Date:
w Completed within 1

Contact: €5mith
O Match any contact name

| Ge... | Op... | Dates]CategorﬂKeyword

day(s)

4.7.2.4 Category

| QK ||Cunce||

This tab contains category filtering options. The filter will only include items whose

category is checked.

Bonsai will not let you define a filter without at least one category checked.
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4.7.25 Keywords

Define Filter o

Select Categories:

[Ge...]Dp...]Dutes]Cutegory IKezword

Unfiled

v After work
Anytime
During Lunch
Morning

v’ Weekend

| OK ||Cunce||

127

This tab contains keyword filtering options. Since you can include more than one

keyword in the filter, there is a set of options that affects how the keywords are

matched.

Define Filter ()

[Ge...IOp...]Dutes]Cutegnry]l(eyword‘

Selected Keywords:

@Home

Delete

| QK ||Cunce||

Show items that have:
w qatleast one selected keyword

© 1999-2006 Natara Software, Inc.




128

Natara Bonsai User Manual

4.8

Beaming

Beam outlines using the Beam command from the list of outlines. Select the outline
to beam from the list of outlines.

ExEort

w Al

Natara Bonsai
Marme [ltems | Category |
Palm_PC Help 83 Personal
test 23 Travel Motes
Rermaodeling 11 Unfiled
ISiness
George Dpen arsonal
ltern Tupes| Diatails Jsiness
Yacation Pr areonal
Category
Copy
Delete
Archive

Fecet

Fename

COper

}etailsj [ Deletej

w Al

Mame [lterms | Category |

Palm_PC Help 83 Personal
test 23 Travel Motes
Retmodeli 11 Unfiled
Citline Hisrarchy

George 7 Personal
[tem Types & Business
Yacation Prep 1 Personal

Preparing: Bonsai
QOutline: Outline
Hierarchy

Cancel

W

Beam

On the receiving handheld, use the menu command View -> Refresh to scan for the

received outline.

The Bonsai application can also be beamed to another Palm device. Bonsai will run
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4.9

49.1

on the new device in the 30-day trial mode. The command is located on the Options
menu.

Preferences

The preferences dialog is available from the Options menu. Note that each outline
has its own set of preferences. Be sure to have the correct outline open when you
modify the preferences.

The initial value for the preferences is taken from a set of defaults. The section
following this describes how to change those default preferences. The preferences
are grouped onto tabs.

General

This tab has general display options. In general, the more attributes selected for
display, the less room for the outline text.

JGenerul]MiscICuchltem]Fn...]Co...I I]
Outline Numbering

Level1: + 123 Level5: + None

Level2: + ab,c Level6: * None

Level3: v 123 Level7: ¥ None

Level4 + 123 Level 8 + None

Show all numbers to level; + 1

Current View:
¥ Show Completion Status
[0 ShowPriority
¥ Show Numbers

’[ OK ][Cuncel]

Numbering Options
reference  Description
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Option Description

Level 1..8 Pick the style of numbering to be used for the outline at each level

Show All Numbers to Level Select the last level that should include all levels in the outline
numbering. For example "1.2.1".

Current View Options

efPreference Description

Option Description

Show Completion Status When checked, check boxes and progress bars are shown for each
item. This option displays the status for the current view.

Show Priority When checked, the priority of each item is displayed. This option
displays the status for the current view.

Show Numbers When checked, outline numbers are shown according to the
definition on the Number tab. This option displays the status for the
current view.

49.2 Misc

This tab has miscellaneous display preferences.

(General|Misc)Calc[ltem[Fo...[Co..] I..

# of lines displayed per item: w All

Dates: RN M.Y [D.M.Y

Custom Label; Cost

] O Color completed items

[ OK ][ Cancel )

Perence Description
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Option Description

# of lines displayed per item When set to All, Bonsai will show all of the item's title in the
outline (as long as it fits on the screen). When the entire
item is displayed, you can edit the text directly in the
outline. Set this option to another value if you want to
restrict the number of lines displayed for each item.

Dates Select what elements of the date should be displayed on
the outline view. You can select: Day - Month, Month -
Year, or Day — Month — Year. This preference does not
control what order is used (Day-Month, or Month-Day).
The Palm OS date preference is used for formatting.

Custom Label The label displayed for the Custom numeric attribute.

Color completed items When checked, the text of completed items will be
displayed in this color.

49.3 Calculated

This tab has options that control the calculation of parent values from children. When
the option is checked the value of the parent will be calculated from its children.
There are three options.

Completion Status
Check this option to calculate the percent complete or checkbox status from the
children items.

Dates

Check this option to calcuate the Start, Due and Completion dates from the children
items. The start date of the parent will be the earliest child date. The due date and
completion date of the parent will be the latest date of the children.

Custom Numeric Field
Check this option to calculate the parent's custom numeric value from the children
items. There are several options for the calculation.
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[GeneruIIMiscICulc]ltem]Fo...ICo...I I]
Calculate Parent Values

M Completion Status
M Start, Due and Complete dates
M Custom numeric field

w» Sum w All children

'( OK ](Cuncel]

49.4 New ltem

This tab contains options for new items, and computing parent status from children.

.|Item|]Fo...|Color| lcons

Insert New ltems As:
Type: » ToDo
Priority: ¥ 1

Start date: ¥ None

Due date: ¥ None
Category: ¥ Parent's

Keywords: ¥ None

Auto-link To Do: [

‘( 0K ][Cuncel]

Several of the preferences have selections of Parent's or Sibling's. This allows the
automatic selection of the initial value when the item is added to the outline. If
Sibling is selected and the item is the first child (i.e., it has no sibling), then the
attribute is taken from the parent.
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Option Description
Type Select the type initially assigned to new items.
Priority Select the priority initially assigned to new items.
Start Date The date assigned to the start date for new items.
Due Date The date assigned to the due date for new items.
Category The category assigned to new items.
Keywords The keywords assigned to new items.
Auto-link To Do When checked, new To Do's added to an outline will automatically
be linked to the standard To Do's.

495 Font

This tab shows the fonts used to display the outline and notes. Tap on the example
to display the font select dialog.

.|Fonts |Color

Qutline font: | Example

Note font; : Erxample

‘[ OK )[Cuncel]

49.6 Colors

This tab is used to define a coloring scheme for an outline. The "Color by" selector
has a list of several attributes. They include; Category, Priority, Outline Level, and
Due Date. Tap on the color box to display the color selection dialog.

Bonsai will remember a color scheme for each Color By selection.
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[Ge...]Mi...]Cu...]lt...]FontsIColorI Icons|

Color by: ¥ Due date
I NoDueDate [l 8-30 overdue
Bl Due >30days [l »30 overdue
Bl Due 8-30days [ Completed
B Due2-7days |

[ ] Due Tomorrow

N
[[] Due Today B
N
N

[ Due Yesterday
B 2-7 overdue

[ OK ][ Cancel )

4.9.7 Category Icons

This tab is used to assign an icon to each category. If there is an icon set present on
the handheld, tapping on the box next to the category name will display the
icon selection dialog.

Preferences ﬂ

Ge...[Mi...|Ca...|It...|Fonts|Color | Icons

‘[ OK )[Cuncel]
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4.10 New Outline Defaults

Each outline has its own preference settings that determine how it looks and
behaves. Once an outline is created, these settings can be modified without
affecting other outlines.

Bonsai has a set of initial preferences that are given to all new outlines.
The preferences dialog displayed from the view that shows the names of outlines is

used to define the settings for new outlines. Changing a setting in this dialog does
not affect any existing outlines.

Outline View [0I'{Z7 ] |

New Outline Prefs... /R
Geor| Keywords
ltem| Global Settings...

Security...

Rem| Beam Bonsai

test ----------- - -------------------------------------------------------
Register...

About

[ Open ] [ New ] [Detuils ] [ Delete ]
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4.11 Settings

New Outline Defaults €

]

JGeneruI]Misc]CuIc]Item]Fo...]Co...] l.

Outline Numbering
Level1: + 12,3 Level5: + None
Level2: v+ 12,3 Level6: ¥ None
Level3: v 12,3 Level 7. ¥ None
Level4: + 12,3 Level 8. + None

Show all numbers to level; « 2

Current View:
W Show Completion Status
[0 Show Priority
¥ Show Numbers

[ OK )[Cuncel]

Application settings apply to all outlines.

4.11.1 Display

This tab has general display options.
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JDispIuy]TnolburILi..."Op...INuv]Co...]

Background Colors:

Indentation Size:
M Shade Toolbar
¥ Show guidelines on notes

[0 Show Simple when Status Filter
¥ Reapply filter while editing

¥ Remember input area status

[0 Resetlist columns to defaults

v §

’[ OK ][Cuncel]

Setting Description

Setting

Description

Background Colors

The alternating background colors used for the outline.

Indentation Size

Set to configure how far each level is indented. You may want to
decrease from the default value if you use heavy indentation to
provide more room for text.

Shade Toolbar

When checked, the toolbar area will be shaded.

Show guidelines on notes

When checked, guidelines are shown in the notes edit dialog.

Show Simple when Status
Filter

Normally, Simple items are filtered out whenever a filter with a
status is used. Checking this option will cause Simple items to
match any status filter setting.

Reapply filter while editing

When checked, Bonsai will compare an active filter against an item
being edited. If any changes to the item cause the item to no
longer match the filter, it will immediately disappear from view.

Remember input area status

When checked, Bonsai will restore the input area to the state when
Bonsai last exited. When unchecked, Bonsai will leave the input
area as it was when Bonsai was launched.

Reset List Columns To
Defaults

Checking this option will reset the columns used in the outline list
view when OK is tapped.

4.11.2 Toolbar

This is the toolbar tab of the settings dialog.
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| Settings O
| Display [ Toolbar |Li...|Op...|Nav|Co..|

Toolbar:

R EFNAEED

Alternate Toolbar:

rkEa ER L4 2.

'( OK ](Cuncel]

Select the icons to appear on the toolbar. To change the icons displayed on the
toolbar, tap on the icon and select a new command from the list.

The available toolbar commands are;

)
e
-

outline links.

k=
£

&

Close this outline and display the list of outlines.

Return to the previous outline or list of outlines. Useful when using

Add a new item as a sibling of the current item.
Add a new item as a child of the current item.
Display details of the current item.

Display the details Dates tab for the current item.
Display the details Links tab for the current item.
Perform a Find or Find Again command.

Expand or collapse the outline to a specific level (selected from pop up
list).

Displays a list of recently used outline. Select an outline from the list to
open it.
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4.11.3 Links

Displays the preferences dialog.
Displays the View selection menu.

Cuts the current branch.
Pastes a branch from the clipboard.
Copies the current branch.

Displays the sort dialog.

Deletes the current branch.
Displays the note for the current item.

Move the current item up (before the previous sibling).

Move the current item down (after the next sibling).

Indent the current item (makes it a child of its previous sibling).
Outdent the current item (makes it a sibling of its parent).
Zoom in on the current branch.

Zoom out (return to a non-zoomed state).

Import To Do's

This is the Links tab of the settings dialog.

139
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4.11.4

[Displuy]Tn...ILinks]Dp...INuvICo...]

e

Bonsailink tag format:

[0 Appendlink tag to notes

[ Delete linked To Do on unlink

Application to launch for link
To Do App: ¥ ToDo List

Datebk App: ¥ Date Book

Contact App: ¥ Address Book

<space> {BZ00}

[ oK

)[Cuncel ]

Setting

Description

Deleted linked To Do on
unlink

When checked, deleting or unlinking an item that is linked to a
standard Palm OS To Do will delete the To Do from the standard
To Do database.

Insert Bonsai link tag in target

When checked, Bonsai will insert a special character sequence into
linked items. The tag has the format "[BZ#]". By using the Back-2-
Bonsai add-on you can view the link context and jump to the Bonsai
outline from the linked To Do or Event.

Append link tag to notes

When checked, the link tag is inserted into the notes of the target. If
not checked, then the link tag is inserted into the title.

To Do App Specifies what application is launched when the link icon of a linked
To Do is tapped.

DateBk App Specifies what application is launched when the link icon of a linked
event is tapped.

Contact App Specifies what application is launched when the contact icon is
tapped.

Options

This tab has some general application options.
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[Di...ITn...]Links]Dptions]Nuv]Conf]

M Delete item clipboard on close
[0 Enter splits item text

[0 SortNo Date to end of list
[ Ignore global find

Initial categories: w Qutline

][Cuncel ]

[ oK

Setting Description

Setting

Description

Delete item clipboard on close

Storage can also be at a premium on a Palm OS device. By
default, items left in the clipboard are deleted when Bonsai exits. If
you want to make those items available the next time you run
Bonsai, uncheck this setting. This does not effect text selections in
the clipboard.

Enter splits item text

When unchecked, a return graffiti stroke or enter key will start a
new item without changing the item where the caret is placed.
When checked, the title of the current item is split at the caret
location to create the new item. This operation is similar to a word
processor.

Sort No Date to end of list

Controls how the 'No Date' value is sorted in relation to other dates.

Ignore Global Find

When checked, Bonsai will ignore the Palm's global find requests.

Initial categories

When creating a new outline, this setting determines the initial set
of categories given to the outline. The selections are; Standard,
Outline, To Do's, and Empty. The standard set of categories is:
Business, Personal, and Unfiled. The Outline set of categories is a
copy of the categories used to categorize the outlines themselves.
The To Do category set comes from the standard To Do database.
The empty set will only contain Unfiled.
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4.11.5 Navigation

This is the navigation tab of the settings dialog.

lDi...ITo...ILinks]Dptions]NuvICnnf|

[0 Soft Arr

5-way DP

M Jog Wheel Scroll by Page
Jog Select: w Item Details

Select:
Left-Right:
Option L-R:

Up-Down:
Option U-D:

ows Scroll by Page

AD:
w |tem Details

w Expand-Collapse
w Cursor left-right
w Page up-down

w (Cursor up-down

[ OK ](Cuncel]

Setting

Description

Soft Arrows Scroll by Page

Select whether the on screen arrows scroll by a line or
page.

Jog Wheel Scroll by Page

Select whether a jog wheel scrolls by a line or page.

Jog Select

Select operation of a Jog wheel select. The options are;
details, note, expand/collapse, and toggle To Do check
mark.

Options for the 5-way DPAD:

Select

Select the operation for the select button. The options are;
details, note, toggle To Do check mark, expand - collapse.

Left-Right

Select the operation for the Left and Right buttons. The
options are; expand - collapse, cursor left - right, cursor up -
down, and indent - outdent.

Options L-R

Select the operation for the Left and Right buttons when the
Option button is also held down. The options are; expand -
collapse, cursor left - right, cursor up - down, and indent -
outdent.

Up-Down

Select the operation for the Up and Down buttons. The
options are; cursor up - down, page up - down, move up -
down, and expand - collapse.

Option U-D

Select the operation for the Up and Down buttons when the
Option button is also held down. The options are; cursor up
- down, page up - down, move up - down, and expand -
collapse.
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Note: Devices like the Palm Treo 650 SmartPhone support the
Option key with the 5-way navigation buttons. The select button is used
to switch between edit mode and navigation between controls. The
Option-Select will perform the commad configured for Select.

4.11.6 Confirmation

This is the confirmation tab of the settings dialog.

[Di...]To...ILinks]Dptions]Nuv]Conf]_
Confirmation prompts:
¥ Delete entire outline
M Delete multiple items
[0 Delete item
¥ Delete item with notes
¥ Delete note
M Cutbranch

[ OK ](Cuncel]

This setting page provides confirmation prompts for delete operations.

4.12 Handheld Shortcuts

While editing an outline on the handheld the keyboard shortcuts for Bonsai are as

follows.
A Display item note.
B Go to bottom of outline.
C Copy selected text.
D Delete current item from outline.
E Return to the list of outlines.
F Find.
G Find next occurrence of text.
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4.13

4.14

Indent current branch.

Cut current branch to the Bonsai clipboard.
Display keyword dialog.

Display details of the current item.

Move current item up (before the previous sibling).
Insert a new child item of the current item.
Outdent the current item.

Paste text from the clipboard into current item.
Toggle the completed status of current item.
Display the outline preferences dialog.

Select all the text for the current item.

Go to the top of the outline.

Undo the last text editing operation.

Move the current item down (after its next sibling).
Copy the current branch to the Bonsai clipboard.
Cut the selected text.

Paste the branch from the Bonsai clipboard.

File the current branch DayNotez.

Expand the current branch.

Collapse the current branch.

Expand all branches.

Collapse all branches.

Sort the outline (displays the Sort dialog).
Display the Filter dialog.

NRPAV'+N<X<XS<CHOITOTOZZIr X« I

Handheld Toolbars

The toolbars for the handheld application are defined on the Toolbar tab of the
Settings dialog.

Printing
Bonsai has support for two print engines:

e PalmPrint Palm OS print driver from Stevens Creek Software
e TealPrint Palm OS print driver from TealPoint Software

Using PalmPrint or TealPrint you can print your outline on compatible printers directly
from your Palm device. For example, you can walk up to an infrared equipped
printer, select an outline or note, and out comes your hard copy.

The print command on the Palm OS application prints the outline as shown. You
can expand and collapse and use the filter to print the desired items.

Visit the Stevens Creek web site at http://www.stevenscreek.com/pilot for more
information about PalmPrint.
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Visit the TealPoint web site at http://www.tealpoint.com/softhome.htm for more
information about TealPrint.

4.15 Outline Management
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4.15.1 Outline List View

This view lists the outlines that are present on your handheld.

Operations performed

on an entire outline are done from this view. Such as;

¢ Open the outline

¢ Display the outline details
¢ Set the outline category

e Copy
e Delete
e Archive
e Export
e Beam

¢ Reset completion status and dates

e Rename

The columns that can be displayed as listed in the following table.

Column Description

Name The name of the outline

Category The category of the outline. Filter on this field using the
selector in the upper right corner.

Sync A check mark appears in this column if the outline is
configured to synchronize with the desktop

Desktop A name appears in this column if the outline is configured
to only synchronize with a single machine.

Size The total size of the outline in bytes.

Items The number of items in the outline.

Last modified

The last time or date the outline was modified. A time is
shown if the outline was modified today. Otherwise, the
date is shown.

On Card

A check mark appears if the outline is stored on a storage
card (CF, MS, SD).

Usage Count

The number of times the outline has been opened.

Private

A check mark appears in this column if the outline is
marked as private.

The view on the handheld that shows the list of outlines can be customized. In
addition to selecting what columns are displayed, the column size and location can

be changed.

If you have installed a new outline on the device by either; beaming, import, or the
Palm Install tool, and it does not show in this view, then use the Refresh command
on the View menu to scan for the new outline.
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Tap on a column header to display a menu with options for sorting and column
selection. Tap on the header past the last column to select a new column for display

as the last column.

Name Hide Header
George Sort Ascending
I'cnemTiis ey Sort Descending
Qutline Hierarch Hide Column
Remodeling

test L AN ERILEE ]

( Open ] [ New ] [Detuils ] ( Delete ]

Tap on the header to display a menu

Name Nc;me

George Category

ltem Tvpes Sync

Qutline Hierarch Desktop

Remodeling S

test ftems |
Last Modified
OnCard ¥

( Open ] [ New ] [Detuils ] ( Delete ]
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Then select a new column to display from the list of columns.

Name | ltems| Categor
George 1 Unfiled
Item Types 6 Unfiled
Outline Hierarch Unfiled
Remodeling 11 Unfiled
test 8 Unfiled
4 =
( Open ] [ New ] [Detuils ] ( Delete ]

Commands available on the header menu.

Command Description

Hide Header Collapsed the header to a narrow line. This increases the space
available to display the names of outlines.

Sort Ascending Sorts the list of outline by the column tapped in ascending order.

Sort Descending Sorts the list of outline by the column tapped in descending
order.

Hide Column Hides the column that was tapped. At least one column must
be displayed.

Show Column... Displays a menu of columns that can be displayed.

Tap on the column separator in the header and drag to change the size of the
column.

Tap and hold on an outline's category to display a menu of categories. Select a
category from the menu to be assigned to the outline.

Tap and hold on an outline's name to display a menu of actions that can be
performed on the outline.

Tap on a selected outline's name to open the outline. Tap on other columns of a
selected outline and the details for the outline will be displayed.
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When using a portable keyboard, the scroll keys will move the selection up and
down, and scroll the display left and right. The Enter key will open the selected
outline.

When using a handheld with 5-way navigation buttons, like the Treo 600, press the
Option button along with one of the navigation buttons to move the focus from the list
to the category filter, or the command buttons.

4.15.2 Outline Details

A view is provided by the Palm application that shows some of the attributes of the
outline and is used for setting the outline's category.

JGeneruI]Stuts]

Category: + Unfiled
[ Private
M Store on Storage Card

w POSESIot1
¥ Synchronize with desktop

[0 Only Synchronize with machine:

(oK ) (Cancel)
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4.16

|Generu| | Stuts]

Items: 11
Size: 12KB
Usage Count: 2
Created: 12/7/05 2:17 pm
Last Modified: 12/7/05 3:00 pm
Backup Date: -

’[ OK ][Cuncel]

Setting Description
Category Select the category for this outline. The view that displays
outline names can be filtered and sorted by category. The
Bonsai desktop application can also group outlines by
category.
Private When checked, the outline will not be visible when the

Palm OS security setting is configured to hide private
items.

Store on Storage Card

Check this setting to store the outline on a storage card.
Some handhelds support more than one storage card slot
or have virtual internal storage cards. Select the
appropriate storage card from the drop list.

Synchronize with desktop

Check this setting to synchronize the outline with the
desktop.

Only Synchronize with machine

Check this setting to setting to only synchronize this outline
with a single desktop. Enter the name of the desktop
machine in the following field.

The usage count is the number of times the outline has been accessed.

How Do | ... ?
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4.16.1 Create a New Outline

Tap the New button on the outline list view and enter the name for the outline. You
can also select the category for the outline, and the initial set of categories for use
with the outline.

There are 4 options for the initial set of categories.
e Standard (Business and Personal).
¢ Outline - Copies the set Bonsai uses to categorize the outlines.
e To Do's - Copies the current categories from the standard To Do application
e Empty - No categories are defined.

Name ltems Categor
George 1 Unfiled
Item Types & Unfiled
Qutline Hierarch 7 Unfiled

New OQutline o

Enter the name for the outline:
Client Web Project

Categories: ¥ Qutline

Category: | ¥ DevProjects
[ oK ] [Cancel]

The name given to the outline will be used for the file name on the desktop during
synchronization.

4.16.1.1 Using Another Outline

Tap and highlight the outline you use as a template. Use the Copy command from
the Outline menu to start a new outline.
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Name | ltems| Categor
George 1 Unfiled
Item Types 6 Unfiled
Qutline H|Open 7 Unfiled

SGIN | 11]Unfiled
test Cuteiori 8 Unfiled

Delete

Archive
Export
Beam

L | Reset E——

[ Open | [ Rename |'tails ] ( Delete]

4.16.2 Delete an Outline

Deleting Both Copies of the Outline
To delete an outline, tap on the outline name, and then tap the delete button. The
outline on the desktop will be deleted during the next synchronization.

Natara Bonsai v All
Name | Items| Categor

George 1 Unfiled
Item Types 6 Unfiled

béle;:e Outline

Are you sure you wish to
delete this outline? The
outline will also be
deleted from the
desktop.

[ OK )(Cuncel]

If you are synchronizing the outline with multiple desktops, see the note in the
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4.16.3

4.16.4

4.16.4.1

multiple desktop topic.

Leaving the Outline on the Desktop
Use the Archive command to delete the outline only the Palm device. The outline on
the desktop will be set to not synchronize.

Move Items to Another Outline

Use the Cut Branch - Paste Branch, or Copy Branch - Paste Branch operations to
move items from one outline to another.

Delete Items

To delete an item, position the caret in the item's title and use the Delete command
from the Record menu. You can also use the Cut Branch command from the Edit
menu or the Cut Branch icon displayed on the bottom of the screen.

If you backspace (or Del) on an empty item, the item is deleted.

The last item in the outline cannot be deleted.

23

Note: Deleting a parent item will delete the entire branch.

Delete Completed Items

A command is available on the Options to delete all completed items from the
outline. The action cannot be reversed, so a confirmation prompt is displayed before
deleting the items.

If all the items in the outline are deleted, a new item is added to the outline.

Items in the outline with the Simple type, which does not have a completion status,
are not effect by this command.

j Note: If a parent is marked complete, the entire branch will be
deleted even if some of the child items are not marked complete, or are
Simple items.
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4.16.4.2 Delete Notes

There is a Delete command on the Note menu to quickly remove a note from an

item.
[L12] Edit View
il Delete
Export to Memo .E
Create To Do S0
Print 7 N
[OK] [Cancel]
4.16.5 Sort

The sort command is used to sort the items in an outline branch. The outline can be
sorted by 2 attributes, so that if items are equal on the first attribute, the second
attribute is used. The current branch (where the insertion caret is positioned) of the
outline is sorted.

There are 2 options for the scope of the sort.
e The sort is only performed on the level of the current item
e Besides the current level, all levels below on the current branch are sorted.

When the current item is on the first level, and the second option is selected, the
entire outline is sorted.

The Sort Branch command is located on the Edit menu.
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'Remodeling v Filter Off |

vl 1 Kitchen

L Tl 1] - (]

Sort Current Branch

ThenBy:

First By:

w Text w Priority

[0 Descending [ Descending

Sort current level only
Sort current level and below

[ OK ](Cuncel]

'Remodeling v Filter Off |

vl | Kitchen

.
Tt o T

‘Text |

First By: Start Date
Due Date
Text
v e % Complete
[ Descending |Category
Comp. Date
Keyword
Sort current ley|Contact
.|Created
(CoK ) (Cancel | cietom

4.16.6 Display Note Icon and other columns

Tap on the right side of the column header to display additional columns in the
outline view. Select "Show Column" from the menu. Select the Note column from the
list of available columns.

© 1999-2006 Natara Software, Inc.



156

Natara Bonsai User Manual

4.16.7

4.16.7.1

Homein lllinois w Filter Off

Text | r"lr‘|| Miie
¥ mo 1, \Windows an|Hide Header
¢ @ 1.4 Family ro|Sort Ascending
¢ & 1.BDining rog Sort Descending
¢ O 1.CKitchens |Hide Column
¢ O 1.0 Master b|Show Colurmn...
¥ B 2, master batlig
¢ o 2Abaseboardss P 5,/ 1

¢ O 2.BBroken tile a0 4730
¢ O 2.CSkylight A 4/30
¥ mm 3, [en 5/

L REORERY ¢

Note: The column header can be collapsed on the handheld to increase the
room for the outline. When the header is collapsed it will appear as a
thin rectangle or line at the top of the screen (but below the title bar).
Tap on the collapsed header to expand it.

Search the Outlines

Bonsai supports both the global Palm OS find application and an internal find
command.

Internal Find Command

Tapping on the binocular icon starts the internal find command. There are also Find
and Find Again commands on the View menu.

When the search text is found in the outline, the view is positioned to the item and
the text is highlighted. Tapping the icon again will find the next occurrence of the
search string.

The internal find command only searches the current outline. To search multiple
outlines use the global find.
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'Remodeling w Filter Off

v ma 1. Kitchen
¢ & a.Install cabinets #|
¢ & b.Install counters
¢ & c. Install sink
¢ & d.Paint =

v B2 Finish trim
¢ & a.First stain coat

Find: child

[ Find ][Cuncel]

j Note: The find text string is not case sensitive.
j Note: The handheld application does not search the notes. Use
the Global find to search the notes text.

4.16.7.2 Palm OS Find

The Palm OS find application searches all applications on the Palm device. Bonsai
supports this feature and will return outlines that contain the search text.
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'Remodeling ¥ Filter Off

w1, Kitchen
¢ & a.Install cabinets #|
¢ & b.Install counters
¢ & c. Install sink
¢ & d.Paint #|
W B2, Finish trim
¢ & a.First stain coat

[ OK ][Cuncel]

Matches for “child”

— Bonsai: Outline Hierarchy ——
This is a child and parent item.

This is a child

A second child item

This parent is collapsed and hides th
This child was hidden
Media
Natara DayNote:z

[ Cancel ] [Find More]

When you tap on one of the matches, Bonsai will display the outline and place the
caret at the search text.

23

Note: The Palm OS Find command does not search outlines
stored on a storage card.
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4.16.8 Jump Back from a Link

Bonsai has an option to insert link tags into linked To Do's and Events. The link tags
help to identify To Do's that are associated with a Bonsai outline. There is also an
add-on called Back-2-Bonsai that will display additional outline context information
and provide the ability to jump back to the Bonsai outline. The link tags can be
embedded in either the title or the note attached to the To Do or Event. Options for
the link tags are in the Settings dialog.

rTnsks- LB Date |Category

¥ 1 Install counters[BZ 1] 12/8
Install sink[BZ2] 12/10

KNEWJ (Detuils...) @

Double-tap on the link tag to display additional information about the outline item.
The first line shown in a bold font is the name of the outline containing the link. The
following lines provide either the full hierarchy of the linked item, or the direct parent.
Tap Close to return to the To Do or Calendar application. Tap the Go To button to
launch the Bonsai application and display the outline. There is an option to jump
directly to the Bonsai outline without displaying this dialog.

© 1999-2006 Natara Software, Inc.



160

Natara Bonsai User Manual

rTnsks- LB Date |Category

¥ 1 Install counters[BZ 1] 12/8
Install sink[BZ2] 12/10
Back-2-Bonsai
Remodeling
Kitchen

(GoTo) (Close)

KNEWJ (Detuils...) @

4.16.8.1 Installing Back-2-Bonsai

The Back-2-Bonsai add-on is installed into the Bonsai installation directory on the
desktop by the Bonsai setup program. Use the file "Back2Bonsai.PRC" for
handhelds running Palm OS 5 . Use file "Back2BonsaiHack.PRC" for handhelds
running Palm OS 4 and earlier. The Palm OS 4 version requires a hack manager like
TealMaster from TealPoint Software.

Double-click on the PRC file to launch the Palm install tool, then click Done. Perform
a synchronization to install the Back-2-Bonsai add-on onto your handheld. After it is
install, configure Back-2-Bonsai.

If you are unsure of what OS your handheld is running, the version number can be
found on the Info dialog. From the Palm application launcher screen, select the Info
command from the App menu. Tap the Version button at the bottom of the screen.
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Device: ¥ Device
Palm O0S® Garnet v.5.4.5

ID: SERIALNUMBER-0O

Quick Tour v. 2.1 i
AboutBoxLib-abxL v.2.1
Address v. 4.5.1.1P
Address Sort Libra..v.540.0
ADPCMCodec v. 3.0
AglkglLib v. 1.0
AppSlipAttMan v. 1.1.1 ¥

TG Size | Records

Do not install the Back-2-Bonsai application to a storage card. It must be installed
into main memory.

4.16.8.2 Configuring Back-2-Bonsai

The Back-2-Bonsai add-on must be configured before it will operate. There is also an
option to display the Bonsai link context in a small dialog when the link tag is double-
tapped.

The Back-2-Bonsai version for Palm OS 5 is configured by running it from the Palm
application launcher screen. After setting the desired options, return to the launcher
by tapping the home icon.
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Natara Back2Bonsai

Back-2-Bonsai

Copyright ® 1999-2005

Natara Software, Inc.
All Rights Reserved

This application watches for

activation of Bonsai link tags and
jumps to the corresponding
Bonsai Outline.

[¥| Enable Back-2-Bonsai
1¥v; Show context before jumping

¥ Show full hierarchy

The Back-2-Bonsai hack will appear in the hack manager on Palm OS 4 handhelds.
Enable the hack and tap the configure button.

TealMaster (28 [Ea ~ EIHBIE
¥ 3 Back2BonsaiHack

@

Info NS

Beam

(Reset (&l on ) All off)

© 1999-2006 Natara Software, Inc.



Bonsai Outliner for Palm OS 163

Natara Back2Bonsai

Configure Back-2-Bonsali

™ Show context before jumping
™ Show full hierarchy

4.16.9 Export an Outline

Once you have created an outline for a document and want to work on the body, you
may want to export your outline. Bonsai provides an export command that can
format the outline either in memo or Doc format.

The Export command is found on the Outline menu of the view that lists the outline
names. The export dialog has several settings for attributes to be included in the
memao.

4.16.9.1 To Palm DOC Format

The name of the Doc database defaults to the outline name and can be changed.
The Doc format also supports the export of the notes.
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Name | ltems| Categor

George 1 Unfiled
Item Types 6 Unfiled
Outline Hi[Open 7 Unfiled
Details | K] VAT
test Category 8 Unfiled

Copy

Delete

Archive

Beam
L | Reset E—— -
[ Open | ( Rename  |tails ] ( Delete ]

m Doc Format

Include in export:
[0 Qutline title

M Numbers
M Completion status
[J Priority
[0 Category
Doc format options:
Name: Remodeling

[0 Notes

| OK || Cancel |
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4.16.9.2 To the Memo Application

lemc Coc Format

Include in export:

O Cutline title

™ MNurmbers

O Completion status

[0 Priority

[0 Category
Doc format options:
Mame: Cutline Hierarchy

0 Motes
( K. j(Cancelj

Memo 3of 3 IUnfiled
Cutline Hierarchy —
1. This iterm has no children
2. Thisis a parent
2.1 Thisis a child and parent
iterm.
2.1.1 Thisis a child.
2.1.2 Asecond child item
2.2 This parent is collapsed and
hides the children itemes. -
2.2.1 d <
[ Donej [ Detailsj

Text from notes can also be exported to the built in memo database. The entire note
can be exported, or make a selection to export a portion of the note.
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D) Edit View |
<D
Create ToDo s O
Print < N
Power Off
Find
[DK] [Cancelj 4+

4.16.9.3 To Natara DayNotez

When a Bonsai outline is used as a To Do list, it's convenient to be able to file away
completed items where they can be referred to in the future. Natara DayNotez
journal provides a great place to file the completed tasks.

Use the File in DayNotez command on the Options menu to move the information
from a completed To Do to DayNotez. The DayNotez entry is created using the
following information:

Item title

The note text can be optionally included

Category (if matching category is found)
Completed Date (if not set, then uses current date)

The private setting and time are set from the dialog.

The item can be optionally deleted from the outline after it is added to DayNotez.
When this option is used, the entire branch will be deleted even if the option to
include the sub-item's text is not checked.
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'Remodeling v Filter Off

Text m&
v == 1. Kitchen| £
¢ [ a.Install cabinets @
¢ [ b.Install counters E
¢ & c. Install sink
¢ © d.Paint @
w B2, Finish trim &

¢ & a.First stain coat

¢ & b.Second stain coat
¢ Ec. First varnish -
¢ O d.Sand - #

-
B BEAMEND ¢

Category: ~ Unfiled

0 Private

M Include notes

¥ Include subitems

O Delete from outline
M Launch DayNotez

Spaces Flat
[ OK ][ Cancel I_
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4.16.9.4

1278705 8 am w Unfiled
itchen

Install cabinets
Install counters
Install sink
Paint

(0K (Cancel) [} (Betas) = =

If you want to edit the resulting DayNotez entry, check the Launch DayNotez option.
DayNotez will be placed into the edit form for the created entry as shown in the last
screen image.

j Note:

The total length of the DayNotez entry is limited to 32K. If the exported
branch exceeds this limit, it will be truncated.

To the To Do Application

An item can be used to create a To Do in the built in To Do database. Position the
caret on the item to export. Use the Create To Do command on the Record menu. If
the item has a note, the note will be attached to the new To Do. The due date and
priority are also used in creating the To Do.

An item's note can also be used to create a To Do. Select a portion of a note and
use the Create To Do command on the Note menu.

4.16.10 Store outlines on a storage card

Bonsai can store outlines on a storage card instead of using the handheld memory.
To use this feature, open the outline details dialog and check the "Store on Storage
Card" option.
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JGeneruI]Stuts]

Category: + Unfiled
[0 Private
[ Store on Storage Card

w POSESIot1
M Synchronize with desktop

[0 Only Synchronize with machine:

(oK ) (Cancel)

When you close the dialog, Bonsai will automatically move the outline from main
memory onto the card. It will create a subdirectory on the card to store the outline in.
Thereafter, anytime you work with the outline Bonsai will copy it from the card to
main memory, and copy it back to the card when you are through.

If you later return to this dialog and uncheck the option, Bonsai will remove the
outline from the storage card and store it in main memory.

Outlines stored on storage cards can be synchronized with the desktop.

4.16.11 Import Data
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4.16.11.1To Do's

The application on the handheld has a command to import To Do's from the
standard To Do database. The import command is under the Options menu.

Tap on the To Do's to be imported. In import icon will be displayed next to each To
Do that will be imported. A separate item is created in the outline for each To Do
imported.

There is an option that affects what is done with the original To Do's. The choices
are:
e Link with To Do — An item is created that is linked to the original To Do.
Changes made to either are reflected between the applications.
e Copy — An item is created using information from the To Do, but there is no
link created between them.

e Move — An item is created using the information from the To Do, and the
original To Do is deleted.

Import To Do's o

Category: « Al
¥ Show completed To Do's

-+l Work on website
Call Bill to discuss new project
[#=+[ElPurchase router

[OK J(cCancel ] [ Al )( Clear )

The items are inserted into the outline following the current item.

4.16.11.2 From Other Outline Applications

An import tool is available to import BrainForest  outlines. The Bonsai setup
program installed the import tool (ImportToBonsai.PRC) into the Bonsai installation
directory. If you need to import old outlines, install the application onto your Palm
device using the Palm Install Tool. An icon for the Bonsai import tool is added to
your application screen.
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=0~
. Imnport from:
%w é 1& BrainForest
Address Bonsai  Bonsailmp
BrainForest Cale Date Book Select outline to import:
@ @ w My wery big outline of stuff
DayMotez  Expense Tlail
Merno Pad  To Do List

Tap the "Bonsai Imp" icon to run the import tool.

Select the outline to import from the drop down list.

Tap the Import Now button.

A message is displayed when the import completes.

Launch Bonsai and go to the view that lists outline names.

Use the Refresh command on View menu to scan for the imported outline

When you are done importing, delete the import tool using the Delete common on
the App menu to free up memory on your Palm device.

4.16.12 Reuse an Outline

Bonsai has a command to clear the status for all items in an outline. The Reset
command is located on the Outline menu on the view that shows the outline names.
The operations performed on the outline are:

e Clear all To Do check boxes
e Set percentage complete of all tasks to 0%.
e Set all dates (start, due, completed) to the 'no date' value

There is an option to not clear the date fields.
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Natara Bonsai v All
Name | ltems| Categor

George 1 Unfiled
Item Types 6 Unfiled
Qutline Hierarch 7 Unfiled

_,Dnmnrlnlinn 1111 lnfilaA
Reset Outline

Are you sure you want
toreset allitem status
and clear all datesin
this outline?

( OK ] [Cancel ] [Stutus Only]

4.16.13 Rename an Outline

Outlines can be renamed on the handheld from the list of outlines. Select the outline
to be renamed, tap and hold to bring up the context menu. During the next
synchronization, the outline on the desktop will be renamed.

Name | Items| Categor

George 1 Unfiled
Item Typeas 6 Unfiled
Outline H|Open 7 Unfiled
SO 1 1]Unfiled
test Category 8 Unfiled

Copy

Delete

Archive

Export

Beam
o — Reset E—
[.-tclils ] [ Delete ]
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=

Natara Bonsai w All
Name | ltems| Categor
George 1 Unfiled

Item Types 6 Unfiled
Qutline Hierarch 7 Unfiled
Remodeling | 11|Unfiled

Rename Outline [ ]

Enter the new name for the outline:

[ OK ][ Cancel )

5 Synchronization between Windows & Palm OS

Once a new outline has been created on the Palm device or the desktop it is ready to
be synchronized. During the first synchronization after the outline is created, the
Bonsai conduit will create a matching outline on the other platform. During
subsequent synchronizations the conduit will synchronize changes from both outlines
into the other.

Synchronization is performed at the item attribute level. For example, if you make a
change to the text of one item on the desktop, and check-off the same item as
completed on the Palm device, both changes will be propagated to the other
platform.

If you change the same attribute on both platforms (e.g., modify the same text) the
conduit will display a dialog box during synchronization to alert you to the conflict.

The desktop application Outline Manager window provides a list all the outlines
configured to synchronize for a given HotSync User. Use the HotSync User
command on the File menu to switch users if you synchronize more than one
handheld at your desktop.
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‘' Natara Bonsai - [Client web proje
@ Fle Edit View Item Outline
E e 3
I8l BP N
9k
=+ 12 3 4
Outline Manager O x
Cutline Name w | Location
£ unfiled
— ﬁ Personal
Q Cutline Hierarchy C:\Docume
% Around the house D:'Test Da
— D Business
Q Client web project D:Test Da
% Callisto D:YTest Da
Q Calgary C:\Docume
5.1 New Handheld Outlines

Outlines created on the handheld will automatically be synchronized to the desktop.
The file name for the outline is taken from the outline name. The outline is created in
the directory configured on the Synchronization tab of the Global Settings dialog.

Bonzai Settings

Garersl | Color | Forts || Bxped | Printing | Synchronization
[#] Show Progress During Synchronization
[] Abwrarys choschk hardheld Ta Do databass for changes

Dieffaik location for new outlines:
D\ Projects E]

Logging during synchronization: | Standard b

Post synchronization command:
|

[ ok J[ comcd J[ or J[ Heb
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Removing the check on the synchronization option, located on the outline details
dialog, will disable synchronization of the outline.

JGeneruI]Stuts]

Category: + Unfiled
[0 Private
[ Store on Storage Card

w POSESIot1
M Synchronize with desktop

[0 Only Synchronize with machine:

(oK ) (Cancel)

Check the "Only Synchronize with Machine" option and enter a desktop machine
name to prevent the outline from synchronizing with any other machine. The Bonsai
conduit will fill in this field with the name of the last machine the outline was
synchronized with.

5.2 New Desktop Outlines

When you save a new outline, you are given the choice to configure the outline to
synchronize. The synchronization status is shown on the status line.

_'i'j v T%’/ Mat Filtered i

User: Jim Tutte Items: 1 Sync: Yes

If you no longer want to synchronize an outline, use the Synchronize command on
the File menu to toggle synchronization off. You are also given the option to remove
the outline from your Palm device during the next synchronization.

If you need to move outline files, use the Move button on the Synchronization dialog.
This command will update the information Bonsai maintains regarding outlines that
are synchronized.

Outlines that are open on the desktop will be automatically saved when
synchronization starts, and reloaded when synchronization completes. If you are
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editing an outline and have made changes that you want to discard, close without
saving before performing the synchronization.

23

Note:
Although it is not necessary to close open outlines during
synchronization, do not actively edit the outlines during synchronization.

5.3  With Multiple Desktops

When the Bonsai conduit recognizes that an outline last synchronized with another
desktop is being synchronized, it will automatically switch to "Handheld Overwrites
Desktop” mode if the desktop outline has not been modified.

23

Note: When you delete an outline, you must also delete the outline from the
second desktop. Otherwise the second desktop will copy the outline to
the handheld during the next synchronization.

5.4  Synchronization Action

Use the HotSync Manager Custom dialog to configure the synchronization action for

the Bonsai conduit. For normal operation, the configuration should always be set to
'‘Synchronize the files'.
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Change HotSync Action [z|

HatSynec Action far Bonzai

==
=hy " |
B-2
o8

ok

* Sunchronize the files Cancel

il

Help
" Desktop ovenarites handheld

| Set az default
" Handheld ovensrites Desktop

" Do nathing
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Index
A -

Action Names 20

Agendus 20
Archive 152
Arrows 142

auto-correct 65

_B -

Back2Bonsai 95, 160
Back-2-Bonsai 97, 159, 160
Background 136

Backup 81

Beam 128
Beaming 128
binocular 156
BrainForest 92, 170
-C -

calculated 51, 131

calendar 117

Category 33, 44, 48, 53, 92, 105, 110, 123, 126,
134, 149

CF 168

clear 97,171

Close 137

collapse 23,137

color 130

Colors 19, 55, 59, 133
column 62,155
Columns 54, 136, 146
command 63

command line 88, 92, 94
Compact Flash 168

Completion 34, 112
completion status 32, 108
conduit 174

configured 173
confirmation 143
Contact 34,114
Copies 137

Copy 75,151, 153

CSv 82,90,92

custom 51,130, 131, 176
Cut 75,137,153

D -

date 34, 112

DateBk 20

dates 33,44, 47,112,123, 126
DayNotez 166

defaults 52, 56, 132, 135
delete 76, 137, 143, 152, 153, 154
depth 13

desktop machine 174
DesktopAddins 97

details 105, 137, 149

Doc 163

DPAD 142

drag 26

dragging 25, 26

dropped 25

Due 34,112

“E -

Enter 57

evaluate 11

expand 23, 137
export 61, 82, 88, 163
external resource 93

_F -

Filter 19, 44, 123, 124
filter list 44, 123

fiter name 45

fiters 19

Find 79, 137, 156, 157
Flat 19, 125

Flat Display 44, 123
font 60, 133

-G -

global find 13
google 80
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group 105
guidelines 136
gutter 29

hack 160
header 101

hierarchy 15, 26
hollow diamond 34, 114
HTML 82

icon 20

Icon Manager 20
icons 20, 42,121, 134
import 90, 92, 170
Indent 137
indentation 25, 136
Insert 23

install 11

installing 11
InstallShield 11
Invert 44,123

_ ] -

Jog 142
Jump 159

_K -

keyboard shortcuts 68, 143
keyword 42,49, 121, 127
keywords 37, 42,119, 121

_L -

launcher 99
License 14
limitations 13

link 35, 37, 44, 94, 95, 115, 116, 123, 159, 160,

161
linktag 35, 95, 97, 115, 139
Link Tags 159

linking 34,114
Links 34,114
linktag 94
Logging 63

M -

machine 174
memo 165

Memory Stick 168
move 25, 74,137,175
MS 168

multiple desktops 176

_N -

Name 44,123

New 6, 75, 151

Next Action 19, 125

No Date 57

note 137,155

Notes 13, 40, 57, 62, 120, 155
numbering 50, 129

_0 -

options 46
organize 72
OoTL 75

Outdent 137

Outline Links 34, 37, 114, 116
Outline Manager 72

Outlook 95

Overdue 98

_P-

page numbers 62
Palm Desktop 97
PalmPrint 144

parent 32,108

Paste 75,137, 153
Post 63

preferences 50, 137
print 62,71,72,144
priority 33, 44, 109, 123
Progress 63
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purchase 13

‘R -

recalculated 32,108
recently 137
registration 13
Rename 77,172
replace 79
requirements 12
Reset 97,171
reverse 125

_S -

Save 75

Scope 19, 125
search 79, 156, 157
select 29

selection gutter 29
setup.exe 11
shortcuts 68, 143
Simple 17, 32, 107
Sort 77,125,137, 154
spell 65

splits 57
Springboard 168
Standard 66

Start 34, 112

status 32, 44, 108, 123
status bar 71
Storage Card 168
subdirectories 74
Synchronization 63, 175, 176
synchronized 173

- T -

tabs 57

Task 17, 32, 107
TealMaster 160
TealPrint 144

Template 72, 75, 82, 88
text 82

text file 90
ThoughtManager 92
title 30, 103

ToDo 17,32, 34,107,114, 168, 170
todolink 35,115

Toolbar 66, 137

toolbar size 57

toolbars 66, 144

Treo 600 142

triangle 23

Type 32, 44,107,123

_U -

update 11
upgrade 11
URL's 93
Usage 146

_V -

version 11
version check 11
Views 101

W -

week start 57
what's new 6

zoom 30, 103, 137
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